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Introduction

Overview

TEMPLATE 

KEYWORDS Welcome to Business Planner, the business software that will help you to develop a successful business plan and assist you in analyzing your ideas so that you can make more informed business decisions.

There are many good reasons to develop or revise a business plan.  These include: 

· Starting a new business

· Launching a new product or service

· Adding a new production line

· Establishing a new industrial venture, business or organization

· Creating new internal policies 

· Developing an annual budget

· Creating or revising a financial plan 

· Preparing a marketing plan

Business Planner is specifically designed to help you plan for the future of your business, to simulate the way a business will be conducted, and analyze your business environment. You can use the Business Planner to analyze almost any business decision that you intend to make. 

Main Benefits

Business Planner’s main benefit is in assisting business people; entrepreneurs, economists and managers to evaluate their business ideas and transform them quickly into professional business plans that serve as the first step in building the business.

Other benefits are:

· Preparing professional financial and marketing plans

· Evaluating and minimizing risks to the business

· Forecasting and evaluating the cash flow

· Saving time and efforts by using a comprehensive planning tool that does not require previous experience in programming or usage of software and/or in financial modeling and budgeting.

Main Features

Below are some of the features that we worked on very hard in order to implement them in the Business Planner and we hope we have succeeded:

Quick to learn, Easy to use 

· Step by step on-line guide for novice user 

· Enhanced on-line help

· A Plan Navigator that helps to identify and utilize functions quickly

Flexible and Customizable

· Easily adjusted to different businesses

· Includes samples by industry

Highly Professional

· Advanced budgeting and planning tools

· Powerful analysis tools

· State of the Art reports and graphs

· Built-in modeling and calculations

· Easy export of data and reports to MS Excel

Main Tools

Business Planner includes many tools that will help you accomplish your business planning tasks easily and professionally. The main tools include:

On-line Help

Extensive on-line help prevents you from losing precious time trying to learn how to use the software. 

On-line Guide to Business Planning 

A detailed on-line Guide to Business Planning puts information on how to prepare your business plan at your fingertips.

Plan Navigator

The Plan Navigator helps you prepare the financial plan by leading you step-by-step through the data entry and analysis screens. 

Samples by Industry 

Business Planner includes sample plans for each major industry type. To start your plan more easily, you can select the sample of the industry that your business belongs to and use it as template for your own plan.

Getting Started
What you need

The minimal requirements to run the Business Planner are:

· Windows 95 or 98 or NT4 (SP6) or 2000 or ME or XP
· Pentium II 350MHZ (or comparable processor) 

· 128 MB RAM or higher

· 35MB disk space (100MB in Windows older than 2000/ ME/ XP)

· Display with 256 colors (8 bits) or more

The screens were designed for resolution (Screen Area) of 800x600 pixels and higher. The recommended screen resolution is 1024x768 pixels or even higher.

( Note: If Windows NT4 is the operating system of your computer it should be updated to Service Pack 6. The update file can be obtained from your computer dealer or downloaded from Microsoft's Internet site. Depending on your version of the Business Planner, the CD of the software may include the update file in a folder with the name Tools. You should run the Service Pack 6 update file before installing the Business Planner.

( Note: The Business Planner CD may include a Readme.txt file in the root directory. This file, if it exists, includes the latest and most updated information regarding the installation and use of the Business Planner and it is important to read it. If the file exists, the installation program will display the contents of the file to you when it is started. 

Installing the Business Planner 

1. Insert the setup CD into the CD drive.

2. The setup program will start automatically in a few seconds. 

( Note:  if your computer is configured to disable auto restart of CD’s you will have to start the setup program manually. Click the Start menu, then choose Run, Type the letter of the CD drive followed by: setup (e.g. D:\setup) and then click the <OK> button   

Follow the on-screen instructions of the setup program to complete the installation of the Business Planner on your hard drive.

During the installation you will be asked to choose where you want to install the Business Planner. Press <Enter> if you want to use the default directory, (recommended)  or type in another drive and directory where you want the Business Planner to be installed.

( Note: On some versions of Windows the installation program will need to restart the computer in order to install updated system components. After restart, the installation program should resume automatically in a few seconds. However, if you wait more than a minute after the computer has restarted and the computer shows no activity and the installation program does not restart, then you should restart it by running the setup program again.

Starting the Business Planner 

Business Planner's setup program creates a group in the Windows' Start menu under Programs. During the installation the group name is displayed and you can change it. The group contains the program’s icon. The setup program will also create an icon on your desktop, unless you un-checked this option during the installation. Clicking either of these icons will start the Business Planner.
Business Planner's main window

The Business Planner's main window components are:

Menu

The menu lets you operate all the different functions of the software. It can be accessed with the mouse, or by pressing F10 or Alt with the underlined letter of the required item. Temporarily irrelevant menu items are grayed out.

Toolbar

The toolbar, located under the menu, gives you quick access to the most frequently used functions. Temporarily irrelevant buttons are grayed out.

Plan Navigator

The Plan Navigator appears as a window, (or bertical bar), on the left of the screen. It can be closed and reloaded according to your need. The Plan Navigator assists you in using the main and most commonly used  functions of the Business Planner. The Plan Navigator’s functions are arrayed in a hierarchical structure (tree structure) and double clicking each item will expand its sub-items or activate its function. 

The Toolbar Buttons

The buttons on the toolbar are as follows:

Open

Open an existing plan file and load its data to the memory

Save

Save the current plan to a file 

Copy

Copy the contents of a marked range to the clipboard

Paste

Paste data from the clipboard to a table or a text box

Calculator

Display the Windows Calculator

Help

Display help for the current window

Navigator

Display/Hide the Plan Navigator

Easy Start Wizard

Display/Hide the Easy Start Wizard

Send To (Pro version only)
Activates MS Outlook with the current plan file pre-attached to the email ready to send to a third party
Quit

Exit the Business Planner

Tips On Using The Business Planner

1. In most of the data screens clicking the right mouse button will display a popup menu that you can use to get quicker access to functions that appear on the toolbar. 

2. The "Compact Database Files" option that appears under the Option main menu, is useful to keep the system database files and the plan files (that were saved in sub folder Plans where the Business Planner is installed) as small as possible. Run it before making a backup of your plan files or before copying a plan file to another drive or computer. The compact procedure runs automatically once in every one hundred times that you start the Business Planner. 

3. If you encounter problems in using the Business Planner try the following steps before calling the help desk: 
- restart the computer and run the software again
- run the "Compact Database Files" as described above
- try to find out if the problem occurs in other plan files

4. When you build a business plan, enter the data in portions and view the analysis screens after each portion. This will enable you to understand more easily the way the data is processed and analyzed and how it influences the analysis results.    

5. Backup your plan files on a regular basis. 

6. Before entering changes in an existing plan, it is a recommended practice to use the Save As option, under the File main menu to save the plan to a file with another name as a backup.      

First Steps

Step 1  - Enter Your Data

From the main menu select Plan, or double click Plan in the Task Wizard. Follow the steps below:

1. Select General from the Plan menu/General data, (or use the Navigator/General data), to load the General Data window. This window enables you to enter general information about your plans, such as the name of your business and the period of the plan. The screen is displayed using a card file type arrangement and you can click the tabs on the top of the cards to display and access the information that they contain. 

2. Under General Data, enter the requested data items, such as the name of the plan, the name of the business, etc. Under Periods enter data about the period for your plan. 

3. Select Tables in the Plan menu and enter each of the tables that appear in the sub-menu. Select Product & Cost and enter names and direct costs of the products or services that you plan to sell. The costs are categorized by Labor costs, Material costs and Other costs. If you chose to enter sales in terms of cash and not units (in General Data window), then enter the profit margins for each product or service. Enter your data in the Market table, the Department table and the Currency table. The data you enter in these tables is used in the succeeding data screens to match the data entry to the business specifications, e.g. The Sales Plan screen will be organized according to the markets entered in the Market Table.

4. Select Sales Plan from the Plan menu to enter prices and quantities or amount of sales that you plan for each product in each market in each period.

5. Select Operating Expenses from the Plan menu to enter specific expenses and salaries for the departments or expense groups that you have previously defined in the Department Table.

6. Select Plant & Equipment from the Plan menu to enter capital investment information, such as equipment purchases and plant investments. Then enter the period for each item over which depreciation will be calculated.

7. Select Financial Parameters to enter financial information such as payable days, interest rates, tax rates, and price trends. 

8. Select Capital Sources to enter details about the financing of the business, such as how much equity will be invested and how much funding will be borrowed and under what terms of repayment.

9. If your business is an existing business, select Previous Periods to enter the company's opening balance, the influences of opening liabilities or assets on the forecast period, and data about historical Income Statement and Balance Sheet. (This option is displayed only if you have defined a Previous Period in the General Data screen).

Step 2 - View and analyze your plan

From the Main menu select Analysis to view the business results of your plan. 

( Note: The software is always aware if projected data has been changed and will perform a calculation before displaying any analysis, screen, report or graph. 
1. Select Highlights to view the main highlights of your business plan.

2. Select the projected pro-forma reports that you want to view: the Profit & Loss report, the Cash Flow, and the Balance Sheet.

3. Select Break-even to run the Break-even analysis of the plan and to evaluate its risks.

4. Select the What-If analysis to analyze how your plan withstands changes to basic parameters and assumptions that you made, such as prices, cost, etc.

5. Select Financial Ratios to evaluate the plan's profitability, liquidity, and stability.

6. Review other Analysis screens and use them according to your needs: the Valuation module, the Indicators screen, the ROA/ROE Analysis and the Survival Ratio analysis.

Step 3 - Generate reports

When you have completed the business plan and reached satisfying results, you can generate various financial reports that include your analysis, data, and assumptions. 

Choose Reports from the Tools menu in the main menu. From here you can view, print, and export the reports to Excel spreadsheets or to HTML documents. 

In the Reports Table select the reports you want to generate and click the OK button. The reports will be generated and presented in the Preview screen. Please refer to the Reports chapter in this User’s Manual for more details on how to customize the reports according to your requirements.

Step 4  - Generate graphs

The Graph generator enables you to produce high quality graphs that present the results of your business planning better than a thousand words… Graphs demonstrate financial figures and trends more clearly than tables or text. 

You can view the graphs on-screen, print them, save to file or export to another application. 

Select the graphs that you want to view or print from the Graph Table and then click the OK button. Each graph will be generated on a separate window. Double-clicking a graph will bring up the Graph Setup form. 

Please refer to the Graphs chapter in this User’s Manual for more details on how to customize the graph according to your requirements.

Main Menu

The main menu includes the following options listed along the top of the main window:

File

Open and save plan files. Set up printer and various parameters that influence the printing and functionality of the Business Planner.

Edit

Editing functions that assist you in data entry, such as Copy and Paste.

View

Tools to assist the user to adapt to the software
Plan

Enter data about your business and plan. Follow these menu options one by one to ensure that you refer to all the required data for the plan.

Analysis

Display and analyze the results of your business plan, based on the data that you have entered.

Tools

Generate Reports and Graphs, load planning template and view an on-line guide for business planning. 
Options

Tools to help the user to manage software operations

Window

Arrange opened windows on screen

Help

Get help on using the Business Planner.

The Menu options are explained in details in the following chapters.

File Menu

The File menu options enable you to load and save plan files, load the Plan Navigator, define the application’s preferences and set printer parameters. To use them, simply click on the desired option and the appropriate form or screen will be displayed.

New

Open a new and empty plan file
Open

Open an existing plan file and load its data.
Plan Table

This function will allow opening of previously loaded plan files where the data displayed includes the plan name, prepared by and company name.

Save

Save the current plan to a file using the given name
Save As

Save the current plan to a file using a different name or to another folder
Delete

Delete the current plan from the disk
Print Setup

Enable you to set up printing options such as orientation, printer driver, etc.
Send To (Pro version only)
Enable you to send the plan that you currently work on, as an attachment to an e-mail (requires Microsoft Outlook).

Exit

Exits the Business Planner.

Load and Save Plans

New

To create a new business plan, select New from the File menu. A new file will be created for a new plan and the General Data screen will be displayed automatically. Enter the name of the plan, the plan’s year and other information that is requested in this screen, and then click <OK> to close the screen and save the information.

The new plan file gets, by default, the name “untitled.bpf”. You can see this name at the top of the screen near the program name. When you will save the plan for the first time you will be asked to give it another name. 

( Note: If the current plan that you are working on was not saved before opening a new file, you will be asked to save it. If you cancel the save you will be asked if to proceed with loading the new file.

Open

To retrieve a previously saved plan, select Open from the File menu. The standard Windows file dialog screen will be displayed, showing a list of files in the last path that you have saved to or retrieved plan files. 

The default path is the sub-folder “Plans” under the folder to which the Business Planner was installed. Change the path if needed and select a plan from the list of files, then click <Open> to load the plan file. 

The Business Planner loads and saves files with a .BPF extension.

( Note: If the current plan that you are working on was not saved before opening another plan, you will be asked, after selecting a plan to load, to save the current plan. If you cancel the save you will be asked if to continue loading the new file. 

Plan Table

The Plan Table displays the list of the plans that were prepared with the software and saved to files. For each plan the table shows the plan name, the company name, who prepared the plan, when was the plan saved and to what plan file it was saved. The name of the file is created when the plan is saved to a file using the Save or Save As.. options in the File menu. The other data is taken from the data that is entered for each plan in the General Data screen. 

The table is updated each time you save the plan that you are working on.

The table is useful in managing and loading the various plans that you are working on.
Buttons

Open
The Open button is used to load the plan that is selected in the Plan Table. Double clicking on the plan row will do the same.
Delete
A plan can be deleted from the table by using the Delete button. This action does not delete the plan file itself but only the line in the table that corresponds to it. If you want to delete the file itself you can use the Delete option under the File menu.
Save
To save the plan that you are working on to a file, select Save from the File menu.

If this is the first time that you are saving this plan (e.g. it was created as a new plan with the name “Untitled.Bpf” as a temporary name) you will be asked to give a name to the plan file.

If the plan was already saved in the past to a file, you will not be asked for anything, you will just see the hourglass on and the plan will be saved in a few seconds to its original file.

As default, the Business Planner saves plans with a .BPF extension.

( Note: The Business Planner always loads the last plan that you were working on the last time that you used it.    

Save As

To save the current plan that you are working on with another file name, or to another drive and directory, select Save-As from the File menu. The standard Windows file dialog screen will be opened allowing you to select a path for the save file and to give it a name.

The default path is the sub-folder “Plans” under the folder to which the Business Planner was installed. Change the path and the file name if needed, and then click <Save>. 

As default the Business Planner saves plans with a .BPF extension. 

Delete
To delete a plan’s file, select Delete from the File menu.

The standard Windows file dialog screen will be opened allowing you to select the plan file to be deleted. 

The default path is the sub-folder “Plans” under the folder to which the Business Planner was installed. Change the path if needed, select a file from the list of files, then double-click on it or click the <Open> button.  You will be asked again if you want to delete this plan and if you will answer ‘Yes’, the plan will be deleted.
Print Setup
The Print Setup loads the Windows standard print setup dialog that is used to define the settings for printing the reports and the graphs. 

These settings include:

Selecting the printer (from the list of installed printers)

Selecting paper size and source
Setting the page orientation: portrait or landscape
Send To (Pro version only)
Enable you to send the plan that you currently work on, as an attachment to an e-mail (requires Microsoft Outlook).
Edit Menu

The Edit menu options are used to assist you in data entry and to transfer data to and from other Windows applications. The Edit menu functions are available for use according to the active window on the screen. When a data entry screen is active most of the edit functions will be available. If an analysis screen is displayed, only the Copy function will be available. Edit functions that are not available are grayed out. The Edit menu options are as follows:

UnDo

Undo the last changes
ReDo

Redo the last Undos
Cut

Delete the contents of a marked range and copy it to the Clipboard

Copy

Copy the contents of a marked range to the clipboard

Paste

Paste data from the clipboard to a table or a text box

Clear

Clear or reset a marked range to blanks or zeros

Insert Row

Insert a new row in the current table

Delete Row

Delete the current row in the current table

Copy forward

Forecast future values according to base period values

Comments

Add/Edit a comment to remind you of information about the entries on this row

Calculator
Activates the Windows calculator

These options are explained in more details in the next chapters.

Editing Functions
Cut 

The Cut option is used to delete the contents of a marked cell or range of cells on a table and copy it to the Clipboard. You can then paste the contents of the Clipboard to another location in the table or to another Windows application. The cut option can be done also by holding the Ctrl key down and clicking the X key.

Copy 

The Copy option is used to copy the contents of a marked cell or range of cells on a table to the Clipboard. You can then paste the contents of the Clipboard to another location in the table or to another Windows application. The cut option can be done also by holding the Ctrl key down and clicking the C key.

Paste 

The Paste option is used to copy the contents of the Clipboard to the table. You can use Paste to import data from another Windows application or from another table in this application. The cut option can be done also by holding the Ctrl key down and clicking the V key.

Clear 

The Clear option is used to delete the contents of a marked cell or range of cells on a table.  The cell/s will be reset to blanks or zeros. 

Insert Row

In the data entry tables (e.g. Product Table) you can use this option to insert a new row before the row that is currently marked. You may want to use this option instead of adding a row to the end of the table in a case where the order of the rows is important.

Delete Row

In the data entry tables (e.g. Market Table) you can use this option to delete a row that is currently marked. Before deleting the row you will be asked again if you are sure that you want to delete it and if you answer ‘Yes’ the row will be deleted.

Copy forward
The Copy forward option enables you to forecast values of future periods based on a figure of a base period. 

In many cases the data for one period (e.g. the first month) is the same as the data for the following periods. In these cases the Forecast module can save you a lot of time by allowing you to copy the value of a base period across the following periods. If you want you may also apply a fixed growth rate to the value that is being calculated so that it will grow steadily from period to period.

( Note:  When the Forecast module calculates the values period by period, depending on the range of selected period columns, it can move from a month column to a quarter or a year column. In this case the Copy forward is aware of the type of the item that is being forecasted and it will calculate the values according to the type, as follows:

If an item is entered in amounts then the Copy forward will multiply the monthly figure by 12 when moving from a month column to a year column.

If an item is entered as a percentage of sales or as number of employees then the value will not be multiplied as described above.

To use the Copy forward follow these steps:

Step 1

In the data entry screen move the cursor to the first period and enter your assumption values for each line.

Step 2

Mark the range of lines and columns of data, whose values you want to Copy forward. You can do this in two ways. If you want to include all the periods in the Copy forward calculation you can mark entire lines by clicking on their line numbers that appear in the leftmost column (if in the Preferences screen under File menu the option “Show row numbers on data screen” is marked). If you want to include only part of the periods you can do it by clicking with the mouse on the first period cell of the first line and then dragging the mouse cursor, with the left button pressed, down to the last line and right to the last period that you want to include in the range. 

Step 3

From the Edit menu or the toolbar, choose Copy forward to load the Copy forward screen. Note that each line selected in the data screen appears also in the Copy forward screen as a line. 

Step 4

In the Copy forward screen you may enter a periodical percentage of change that you expect for each item during the forecast periods. This percentage will be applied in the Copy forward calculation as in the following example: a value of 100 is entered in the first period. Then the Copy forward is loaded and you enter 10% as the expected periodical change. The Copy forward will calculate the value for the second month as 110, and then a value of 121 for the third month (10% on the previous month), 133 for the third month, etc. 

Step 5

Click the OK button. The Copy forward screen will be closed and you will return to the data screen from where you started. The screen will include the values that the forecast calculated. 

Comments

This feature will enable you to add or edit an existing comment for each row in a screen that applies the Comment feature.  This includes all the data screens (except General Data screen) and the Profit and Loss, Balance, Operating Cash Flow, Cash Flow Statement and Financial Ratios analysis screens. 

The Comment screen is accessed by clicking the right mouse button and selecting it from the pop-up menu. You can also select this option from the main Edit menu where it is active when a screen containing the Comment feature is displayed.

The comment entered in the Comment screen is saved automatically on exiting the screen by clicking the <OK> button and a small green marker will be shown in the description cell in the upper right hand corner, to remind you that you previously entered a comment for this line. The Comment screen can be moved to any location on the main screen by dragging it with the mouse cursor over the text at the top of the screen. It can also be resized and it will remember its last size and position when you open it again.

View Menu

The View menu utilities are used to customize the way thee Business Planner displays on your screen.The view screens are as follows:

Plan Navigator

Tree structure to left of screen to enable easy access to most commonly used features
Easy Start Wizard

The Easy Start Wizard will lead you, step by step, through the preparation and the analysis of the Business Plan, giving you specific explanations for each screen.
User Defined Text
This feature enables you to modify the texts that you see on the main program interface.

Application Functions
The Application Functions screen will allow you to hide functions that you may deem to be unnecessary to the way that you want to implement the Business Planner.
Navigator Mode
The Plan Navigator can display items according to three modes that are selected by the user: Simple, Medium or Full.
Plan Navigator

The Plan Navigator displays the main functions of the Business Planner in a hierarchical tree structure on a bar, which is docked to the left of the screen. It was designed with the novice user in mind but it serves the experienced user as well. 
The Plan Navigator actually shows the same functions that can be operated from the Plan menu and the Analysis menu but it is much more convenient and quick to use because, unlike a menu, it is displayed fully all the time.

As a default, the Plan Navigator is loaded automatically when the Business Planner is loaded. You may change this by unmarking the check-box "Load Plan Navigator at start up" in the Preferences screen.

The Plan Navigator window can be removed and loaded again whenever you need it, simply by clicking the <Plan Navigator> button [image: image1.png]


 on the main toolbar.

The Plan Navigator display
The Plan Navigator display is a tree (outline) and you can see the main items - General, Tables, Plan, Analysis, Reports and Graphs - in bold fonts and the sub items in regular fonts. 
Selecting an item, by clicking on it with the mouse, will display a brief explanation concerning this item in the small yellow window at the bottom of the Plan Navigator bar. 
Double clicking an item will load the window related to this item where you can enter data or see the analysis results.
Item Sensitive Help
The Plan Navigator presents a short explanation to each item. The explanation is displayed in a small yellow box at the bottom of the tree. This shortened help explanation can be shown/hidden by clicking the small button that appears below it.
Plan Navigator Mode
The Plan Navigator can display items according to three modes that are selected by the user: Simple, Medium or Full.  The selection is done by clicking the "Navigator Mode" button in the toolbar on the top of the navigator or the Edit/Navigator mode button on the menu.
When the Simple mode is selected, the Navigator will show the main and most used planning functions of the software. 
When the Full mode is selected the Navigator will show all the planning functions. 

Easy Start Wizard

The Easy Start Wizard will lead you, step by step, through the preparation and the analysis of the Business Plan, giving you specific explanations for each screen.

The Easy Start wizard is displayed automatically when you first run the Business Planner. 
You can close it whenever you like by clicking the Cancel button, and reload it whenever you want by clicking its button on the main toolbar [image: image2.png]


, or by selecting it from the View menu.

The Easy Start Wizard is designed to be easy to use. It's screen includes a header and explanation referring to the current step or screen that is being handled. You are asked to view the displayed data or to adjust/enter your own data. You use the Next button to move to the next step or the Back button to return to the previous step.

Main Stages
The Easy Start Wizard includes two main stages: 

· The first stage is a series of screens that allow you to enter General data about your plan where you are asked to fill-in a few parameters for the business plan, according to your needs. These parameters are similar to the parameters that you enter in the General Data screen when you use the software without the wizard.

· In the second stage the wizard resizes itself to a bar under the main toolbar, and starts to display the data screens of the software one by one as you click the Next button. When a screen appears the bar displays an explanation that refers to the screen being displayed. When you click Next the present screen is closed and the next screen appears. If the screen is a data screen, when it is closed all the data that was entered or altered will be saved automatically. 

( Note: when a data screen is displayed by the wizard the OK and Cancel buttons on its toolbar are disabled. When the screen is displayed without using the wizard, these buttons are active and you can decide whether to save the data entered or to discard any changes when closing the screen. 

When the Easy Start wizard is displayed, the Plan Navigator is not active. When the wizard displays data and analysis screens you can see that the name of the current screen in the Navigator is marked, but you can not select another screen from the Navigator, as you do when working regularly without the Easy Start wizard.

Buttons

Back
Close the currently displayed screen and display the previous screen 

Next
Close the currently displayed screen and display the next screen 

Cancel
Close the Easy Start wizard.

Show Easy Start Wizard on application startup
When the Easy Start Wizard is displayed you can use the check-box, that appears at the bottom of the wizard near the navigation buttons, to set it to run automatically when the Business Planner is started or not to run automatically.
User defined texts

This feature enables you to modify the texts that you see on the main program interface - specifically the Plan Navigator and the Data and Analysis menu items. The modified texts also appear on the generated screens. For instance, the user may want to replace Operational Expenses by Budget Expenses.
Items modified in this screen can be reset to the original by deleting the user defined text from the screen.
If the <Clear All> button is used, all the modified texts revert to the original texts.
Enable User Defined Text 
This option defines if User defined text will be used. Usually the option will be marked and the user defined text will be used. But, when you want to temporarily return to the system default texts without erasing the text defined by you, e.g. when working with another user who is not familiar with your specific defined texts, you can disable the use of User defined text by unmarking this option. In the future you can easily return to use the user defined text by marking this option again.
Application Functions

The Application Functions screen will allow you to hide functions that you may deem to be unnecessary to the way that you want to implement the Business Planner. If you wanted to hide the Provisions function displayed in the plan navigator, (and from the Menu items), you can un-check this line in the Application Functions screen and, on clicking the OK button, this item will remain hidden until you check the box at some future time.

Buttons
OK  - Implements the Show/Hide indicated by the checkbox.

 

Cancel  - Leaves the situation as it was

 

Mark All  - Marks all the checkboxes making all functions visible on exiting the screen

 

Navigator Mode

The Plan Navigator can display items according to three modes that are selected by the user: Simple, Medium or Full.  The selection is done by clicking the "Navigator Mode" button in the toolbar on the top of the navigator or the View/Navigator mode button on the menu.
When the Simple mode is selected, the Navigator will show the main and most used planning functions of the software. 
When the Full mode is selected the Navigator will show all the planning functions. 
The Medium mode is in between the other two modes, it will show the functions that are used by experienced users that do not require the most advanced functions and reports of the software. 
These modes can be used as a tool that enables a new users to learn the software more easily and it can help experienced users to focus on the planning steps that are necessary for them.

Plan Menu

The Plan menu screens are used to enter the projected information about your plan. The plan screens are as follows:

General Data

General information about your plan such as: the Company name, the plan period, etc.

Tables

Basic information on the Business’s Products, Markets, Departments/Expense Types and Currencies. Previous periods data can also be entered if applicable.
Plan Data

Projected information for the plan periods, including the following:
Sales Plan

Projected sales information 

Operating Expenses

Projected operating expenses information for departments/expense groups

Plant and Equipment 

Projected investment in plant and equipment and depreciation information

Financial Parameters

Projected financial data such as: interest rate, tax rate, terms of payment and cost trends

Provisions

Projected provision data for pension, salary and others 

Capital Sources

Projected equity information and loan tables

Actual Data
Actual data that is entered when each plan period is finished. This data enables to compare Actual results to the Plan.
General Data

The General Data window enables you to enter general information about your plan and to define the plan period. The screen is arranged in a card file structure, with tabs that include various information that you should enter, as follows:

General Data Tab

Plan Name

Enter a name or a short description of the sales plan. 

Company Name

Enter the name of your company or business. 

Prepared By

Enter your name here. 

( Note: The above three items will be used in the reports and will appear, as default, at the header of each report (using the report customization screen you will be able to remove it from the report). 

Currency Units

Enter here the units in which your currency figures throughout the program will be presented (e.g., Thousands or Millions, etc.). You may select the description from a list. Leave the field empty if you want to enter amounts in units. 

Basic Currency Code

Select the basic currency code from a list that displays the codes entered in the Currency Table. At least one currency should be included in the Currency Table in order to use the Basic Currency Code dropdown list. Then, in some of the Data screens, you will be able to select a specific currency code for each item, (e.g. Sales Plan prices), while in other data screens, the basic currency code will be in effect. 

Analysis Currency Code

Select the analysis currency code from a list that displays the codes entered in the Currency Table. At least one currency should be included in the Currency Table in order to use the Analysis Currency Code dropdown list. The analysis screens, reports and graphs will be presented in the currency code selected for the analysis, and all amounts will be translated to this currency according to the exchange rates entered in the Currency Table. 

Discount Rate

This field should reflect the average cost of money to you, which includes your risk factor. It is used to calculate the Net Present Value of your business.

As a default you can choose your discount rate from the following table:

Risk Level

	
	Low
	Medium
	High

	On going business
	8%
	15%
	20%

	Start up
	10%
	20%
	30%


Sales by Units or Cash

The choice of sales type will reflect the way that the input windows of Product and Cost and Sales Plan will be displayed to you.

There are two ways to generate the revenue and the direct cost forecasting:

1. Sales by units- In this method you are required to estimate the sales quantities, the unit price and the unit cost

Example:
ABC Inc. is a manufacturer of air condition systems. The estimated sales for 2002 are 1000 units, and 1500 units in 2003. The unit price is $1000 and the production cost is $ 500 per unit.


The Forecast
	
	2002
	2003

	Sales Quantities
	1,000
	1,500

	Unit Price- $
	1,000
	1,000

	Unit Cost- $
	500
	500

	Revenue
	1,000,000
	1,500,000

	Cost Of Good Sold
	500,000
	750,000

	Gross Profit
	500,000
	750,000


If you choose to forecast the sales by Units, the Product & Cost window will enable data input of direct costs for each product or service, while the sales plan will be entered in units and price per unit.
2. Sales by Cash - In this method you are required to estimate the sales revenue and the profit margin.

Example:
Mr. Joe Brekman considers opening a new business, a super market. He estimates that in 2002 the sales revenue will be $ 300,000 and in 2003 the sales will be $ 400,000. The average profit margin in this business is about 30%.

The Forecast
	
	2002
	2003

	Sales Revenue
	300,000
	400,000

	Profit margin
	30%
	30%

	Cost Of Good Sold
	210,000
	280,000

	Gross Profit
	90,000
	120,000


If you choose to forecast sales by Cash, in the Product & Cost screen you will be asked to enter the profit margin or mark-up in% for each product or service type, while in the Sales Plan screen you will enter the sales amounts.
Period Data Tab

Forecast Period (Years)

Select the number of years for the plan forecast. Up to ten years are enabled. This figure will be applied in all the data entry, analysis, reports and graphs screens.

Historical Period

Select the number of years for which you want to enter historical data. You can enter data of Balance Sheet and Profit & Loss Report for up to five previous years. This information is included in the calculations, reports, and graphs.

Initial Year

Enter the first year of the forecast period i.e. 2003.

Initial Month

Enter the first month of the forecast period, which usually is the beginning of the fiscal year.

Period Type

For each year select the type of period: Month, Quarter or Year. This will define how data will be entered for this year and how the plan results will be calculated and presented in the analysis screens, reports and graphs.  The type of period for a year can’t have greater division than the year before it, namely if the previous year is in months the current year can be in months, quarters or a year, but if the previous year is in quarters then the current year can be in quarters or a year, not in months. If the previous year’s period type is a year then the current year’s period can only be a year.

Previous Financial Reports

If you defined in the Historical Period field mentioned above, that you want to enter data for one or more historical years, you will be able to use the Previous Periods screen to enter data for the Previous Balance Sheet and the Previous Profit & Loss Report. 
Sales Tax Data Tab

In the Sales Tax tab enter data that will be used to calculate the Sales Tax payments and returns.

Sales Tax Rate (%)
Enter the rate of the Sales Tax in your country. It will be used to calculate Sales Tax on the expenses and purchases of your business. The expenses that the software calculates for the Sales Tax include all the direct product costs and the expenses entered in the Operating Expenses screen, excluding the labor cost and the salaries. Investment in plant and equipment are also calculated unless they are marked as without Sales Tax in the Plant and Equipment screen.

( Note:  If there is more than one Sales Tax rate in your country, enter the rate that is used for most of the purchases and use the Sales Taxable Expenses field to get the effect of other rates that are paid on part of the expenses.

Sales Taxable Expenses (%)
This parameter is functional only if the option "Specify Sales Tax rate for each expense type" is not checked

Enter the % of expenses on which Sales Tax will be calculated. This figure is usually 100% but it can be changed in cases that you have more than one rate of Sales Tax in your country or in cases when part of the expenses are exempted from Sales Tax. 

( Note: The Sales Tax on sales is calculated according to the data entered in the Sales Plan window for each product in each market.
First Sales Tax Month
Enter the first month from the beginning of the year, in which Sales Tax is paid to the tax authorities (usually January. Change it only if the business is exempt of reporting Sales Tax payments/returns in the first months of its activity).
Months Sales Tax Payable
The number of months between each Sales Tax report to the tax authorities.

Specify Sales Tax rate for each expense type
This parameter will open a column in the Operating Expenses screen,  the Products and Cost screen and the Plant and Equipment screen to enable you to enter the Sales Tax rate for each item. If this parameter is checked, then the 'Sales Taxable Expenses (%)' is grayed out.
General Parameters Tab
Here you can specify parameters that will affect the calculations

Discount Rate
This field should reflect the average cost of money to you, which includes your risk factor. It is used to calculate the Net Present Value of your business.

As a default you can choose your discount rate from the following table:

Risk Level
	 
	Low
	Medium
	High

	On going business
	8%
	15%
	20%

	Start up
	10%
	20%
	30%


Specify days payable for each expense type
This parameter will open a column in the Operating Expenses screen and the Plant and Equipment screen to enable you to enter  the days payable parameter for each expense type. If this option is not marked , the software will calculate the days payable for all the expenses according to the parameters entered in the Financial Parameters screen.

Buttons

The buttons at the bottom of the screen are:

OK
Close screen and save all changes

Cancel
Close screen without saving the changes

Help
Show the on-line Help for this screen

Tables

The Tables include information that is used in subsequent data screens, e.g. The Sales Plan screen will be arranged according to the products and markets entered in the tables and for each sale you will be able to choose the currency from the list of currencies entered in the Currency Table.  

The tables are as follows:

Product & Cost

The products and services that the business is selling and its direct cost

Markets

The markets to which the business is selling its products. Each market serves also as a profit center to which expenses are allocated in the Operating Expenses screen. 

Departments

The main business’s Departments or Expense Groups   

Currency Table

The Currencies used for the sales and purchases of the business

Previous Periods

Previous data from financial statements. 

( Note: In the tables do not enter descriptions (e.g. product name, market name, etc.) that are longer than 100 characters in length. 

These tables are described in more details in the following sections.

Toolbar Buttons

All the tables include a similar toolbar that appears at the top of the window and includes the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Add

Add a line for a new item after the last line

Insert

Insert a line for a new item above the current line

Delete

Delete the current line

Print

Create a report for the current table, showing it on the print preview screen

Export to MS Excel file 

Exports the displayed table to MS Excel

Product & Cost Table

In the Product & Cost table you enter the description and the direct cost of the products and services that your business is selling. This table will be used later in consequent data and analysis screens, e.g. In the Sales Plan screen you will enter the projected sales for each product that is included in the product table. 

The table is organized according to the definition you have entered in the General Data screen for the item “Sales Forecast by”.  The method that the software will use to calculate the product cost is different if the sales forecast is done in units or cash and so is the data entry.

Sales Forecast by Units

Enter the costs of producing or purchasing the products or services you plan to sell. For each product unit enter the cost - detailed by Labor Cost, Material Cost and Other Costs. 

Sales Forecast by Cash

Enter the mark-up of each product or service as a percentage of your purchasing price, or enter the gross profit margin as a percentage of your selling price.

( Notes: 

When you open the Product & Cost (or Product & Margin) window, the Sales Plan window closes automatically. When you open the Sales Plan window, the Product & Cost (or Product & Margin) window closes automatically.

Do not duplicate these costs elsewhere as variable expenses, as in an expense group called 'Production', for example.

Use the toolbar buttons to add a new product. When the cursor is on the last row and you click the Down button, a line for a new product is also added automatically.

Market Table

In the market table you enter the description of the markets to which your business is selling its products and services. This table will be used later in other data and analysis screens, e.g. In the Sales Plan you will enter the projected sales by markets. Use the toolbar buttons to add a new market, delete an existing market, etc.

Department Table

In the Department Table you define your business structure by departments or expense groups. The departments are used in the Operating Expenses window in which you enter the projected operating expenses for each department. Sample definition of the departments according to the business industry is as follows:

Manufacturing business: Production, Marketing, G&A (General and Administration)

Hi-tech business: R&D (Research & Development), Marketing, G&A 

Resale business: Personnel, Operation, Marketing, G&A

Service business: Personnel, Marketing, G&A  

Currency Table

In the Currency Table you define the various currencies that you will use in your plan and their projected exchange rates during the plan period.

The table contains the following columns.

Currency Code

Give the commonly used code for the currency e.g. DEM for Deutsche Marks. 

Description

The name that describes the currency e.g. US Dollar.

Exchange Rate

Enter a value that will be used as the basic exchange rate. When you enter a value it is duplicated automatically to all the periods of the plan. 

( Note:  the exchange rates of all the currencies should relate to one currency that will be the basic currency, e.g. If you use Euro and US Dollar in your plan, one of them should have an exchange rate of 1 and the other should have the related exchange rate. 

In the period columns, you may alter the exchange rate for each period if you assume it will be changed.  The system takes the basic exchange rate for calculations until it reaches a period with a different rate. Then this rate will be used until another period with a different rate is encountered. If an exchange rate per period is zero, the exchange rate for this period will be the same as in the previous period.  

Toolbar Buttons

The Currency Table includes the same toolbar buttons that the other tables have, as described above, with the addition of the Forecast button:

Forecast

Copy cell values across next periods

Previous Periods
The Previous Periods screen is used for an existing business to enter the data of its financial reports in previous years and the influences of its existing financial state on the plan period. The software includes this data in the calculations and in the projected financial reports.

( Note: The screen will be enabled only if you specified a number of previous years in the General Data screen.
The screen includes three sections:

Previous Balance Sheet

Balance information for the previous years

Opening Balance Influences

Information of changes in existing liabilities and assets that are expected in the plan period.

Previous Profit & Loss

Profit and Loss information for the previous years

When the screen is loaded the Previous Balance is displayed. You can switch between the three sections by clicking their buttons on the toolbar. The sections are explained in more details in the following pages.

Toolbar Buttons
All Previous Period tables include similar toolbar that appears at the top of the window and includes the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Print

Create a report for the current table, showing it on the print preview screen

Export to MS Excel file 

Exports the displayed table to MS Excel
Change display Buttons

Balance

Display the Previous Balance table

Influences

Display the Opening Balance Influences table

Profit and Loss

Display the Previous Profit and Loss table

Previous Balance

The Previous Balance is used to enter the Balance information for the previous years. While you enter data the subtotals and totals of the balance are calculated automatically. 

( Note: For each of the previous years the Total Assets should equal Total Equity and Liabilities, otherwise you will not be able to save and close the screen. 

( Note: the accumulated depreciation is entered as a negative figure.
The Previous Balance row items are explained in more details in the Analysis Balance screen explanation.

Opening Balance Influences

The Opening Balance Influences screen is used to enter the expected changes in assets and liabilities that appear in the opening balance. The figures you enter here will affect the balance sheet and the cash flow that are projected for the plan period.

( Note: the accumulated amount you enter for each row during the plan periods should not exceed the amount that appears for the related item in the opening balance, otherwise you will not be able to save and close the screen. 

The Opening Balance Influences items are as follows:

Depreciation

Depreciation calculated for the plan period on the fixed assets that appear in the opening balance.

Accounts Receivable

Payments from customers that should be received during the plan period.

Other Accounts Receivable

Sales Tax Rebate and other Receivables whose payments will be received during the plan period.

Long Term Liabilities

Repayments of long-term loans and debts (Principal only).

Accounts Payable

Payments to suppliers and other Accounts Payable that should be done during the plan period.

Other Accounts Payable

Payments to Other Accounts Payable that the business owes them amounts as appear in the opening balance 

Sales Tax Payable

Payments to the Sales Tax authorities 

Tax Payments

Payment of tax payable to the tax authorities due to last years profit.

Salary & Benefits Paid

Payments of Salary & Benefit for which a provision was done in previous period and appears in the opening balance.

Interest Payments

Payments of interest on long-term liabilities.

Previous Profit and Loss

The Previous Profit and Loss screen is used to enter the Profit and Loss Report information for the previous years. While you enter data the subtotals and totals of the Profit and Loss are calculated automatically. 

The Profit and Loss items are explained in more details in the Analysis Profit and Loss screen explanation.
Plan Data
The Plan Data screens are used to enter the projected information about your plan for the plan period, including sales, operating expenses, investments in plant and equipment and more.
Sales Plan

In the Sales Plan screen you enter your projected sales figures for each product or service, for each period and for each market. The products or services are those that you have defined in the Product & Cost screen. The periods are defined in the General Data screen and the markets are defined in the Market Table. 

The markets appear in list on the left side of the screen and the sales plan data for the selected market appear on the table in the middle of the screen. When the screen is loaded, the selected market is the first market in the list. To switch markets after entering sales plan data for the selected market you simply click another market on the list. The data for the previously selected market is saved, the new market becomes the selected market and its sales plan data is displayed to the screen ready to be edited.

The columns that the Sales Plan table includes are as follows:

Sales Price 

If you chose Sales Forecast by Units in the General Data window, enter the unit’s sales price here.

Currency Code 

Select the currency code from a list that displays the Currency Table data. The sales amounts in each currency will be translated to the analysis currency according to the exchange rates that are entered in the Currency Table.
Payment Days

The average number of days until payments from customers are collected. This is used to calculate the cash receipts derived from the sales.
Sales Tax
The % of Sales Tax due to be collected on sales.
Sales Plan by Periods

If you chose Units in the General window, enter the sales plan in units. If you chose Cash in the General window, enter the sales plan in cash.
( Note: when you open the Sales Plan window, the Product & Cost window is closed automatically.

Toolbar Buttons

All the tables include similar toolbar that appears at the top of the window and includes the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Print

Create a report for the current table, showing it on the print preview screen

Forecast

Copy cell values across next periods

Export to MS Excel file 

Exports the displayed table to MS Excel
Operating Expenses

In the Operating Expenses screen you enter the operating expenses and salaries for each of the departments or expense groups defined in the Department Table. 

The departments appear in list on the left side of the screen and the operating expenses data for the selected department appear on the table in the middle of the screen. When the screen is loaded the selected department is the first department in the list. To switch department, you simply click another department on the list. The data for the previously chosen department is automatically saved, the new department becomes the chosen department and its operating expenses data is loaded to the screen ready to be edited.

The operating expenses of each department are entered in three different sections: fixed expenses, variable expenses and personnel salary and cost. The buttons at the top of the screen enable you to switch between the three sections. The data entry is different for each section and is described below.    

( Note: You should not duplicate production and labor costs already included in the Product & Cost window.

Fixed Expenses 

In the Fixed Expenses screen you enter data for operating expenses that are not related directly to the sales and do not change immediately with the level of sales, e.g. rent of offices, equipment maintenance, etc. The data is entered in amounts per each period. 
The columns that the Fixed Expenses table includes are as follows:

Description

Description of the expense item

Currency

The currency used to pay for the expense. The currency code is chosen from a drop down list of currencies entered in the Currency Table.

Profit Center

Each expense item can be allocated to a profit center and you can view the processed data in the Profit Centers screen under Analysis menu. This analysis displays the profitability of each of the business units. Analyzing this may provide you with more accurate information and understanding about the business and the keys to its success. The Business Centers are defined as the markets in the Market Table.
Variable Expenses

In the Variable Expenses screen you enter operating expenses that change with the level of sales or direct costs of the business. E.g. Commissions for sales people are, in many cases, percentage of sales. The expenses are entered in each period as a percentage of the total sales, or direct costs or sales for each market.

The columns that the Variable Expenses table includes are as follows:

Description

Description of the expense item

% Of

Select from a drop down list the item from which the expense will be calculated as a percentage, namely: total sales, direct cost, sales per specific market.

Profit Center

Each expense item can be allocated to a profit center and you can view the processed data in the Profit Centers screen under the Analysis menu. This analysis displays the profitability of each of the business units. Analyzing this may provide you with more accurate information and understanding about the business and the keys to its success. The Business Centers are defined as the markets in the Market Table.

Salary & Staff (Personnel)

In the Salary and Staff screen you enter the type and salary cost of the employees that the business hires.

For each type of employee you enter the annual salary, social expenses and benefits. Then you can enter the number of employees that you plan to have for each type in each period, e.g. you can enter “Programmers” as the type of employee, then the average salary of a programmer and then the number of programmers you need in each period. 

In a small business with existing employees you may use each row to enter the specific name of an employee, his/hers salary, social and benefits and then 1 as the number of employees in each period.

The columns that the Salary and Staff table includes are as follows:

Description

Description of the employee type or a name of an employee

Annual Salary

In this column enter the total amount of salary that is paid to the employee in a year, excluding the social expenses and benefits, which you may enter in the following columns (as a percentage of the salary). In case you prefer to include social and benefit expenses as an amount added to the salary, then you should not re-enter its percentage in the following columns. 

Currency

The currency in which the salary is paid. The currency code is selected from a drop down list of currencies entered in the Currency Table.

Profit Center

Each expense item can be allocated to a profit center and you can view the processed data in the Profit Centers screen under the Analysis menu. This analysis displays the profitability of each of the business units. Analyzing this may provide you with more accurate information and understanding about the business and the keys to its success. The Business Centers are defined as the markets in the Market Table.

Social Expenses

The social expenses as a percentage of the salary. 

Benefits

The benefits as a percentage of the salary including social expenses. There are two pairs of columns prepared for the benefits data in case there are benefits that are paid in different months.

Month Paid

The month in which benefits that were calculated during the year are paid.

Toolbar Buttons

The toolbar in the Operating Expenses screen includes the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Add

Add a line for a new item after the last row

Insert

Insert a row for a new item above the current row

Delete

Delete the current row

Print

Create a report for the current table, showing it on the print preview screen

Forecast

Copy cell value across next periods

Export to MS Excel file 

Exports the displayed table to MS Excel
Additional Display Buttons

Fixed Expenses

Display the Fixed Expenses table for the selected department

Variable Expenses

Display the Variable Expenses table for the selected department

Salary and Staff

Display the Salary and Staff table for the selected department

Plant and Equipment

In the Plant & Equipment screen you enter the investments that you plan to make in plant, equipment and other fixed assets, e.g. production machinery, office furniture, etc. The columns that the Plant & Equipment table includes are as follows:

Description

Enter the Description of the investment.

Depreciation Years

Enter the depreciation period, in years, by which the investment is depreciated. Depreciation is calculated by the Straight-Line method.

Currency

The currency in which the investment is paid. The currency code is selected from a drop down list of currencies entered in the Currency Table.

No Sales Tax
Mark the No-Sales-Tax box the exclude the specified item from the calculation of Sales Tax. Investment items for which the No-Sales-Tax option is not marked, will be included in the calculations of Sales Tax according to the Sales Tax rate entered in General Data screen. 

( Note: The investment amounts entered in the periods should be net (without the Sales Tax amount).

Toolbar Buttons

The toolbar buttons are as follows 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Add

Add a line for a new item after the last row

Insert

Insert a row for a new item above the current row

Delete

Delete the current row

Print

Create a report for the current table, showing it on the print preview screen

Forecast

Copy cell value across next periods

Export to MS Excel file 

Exports the displayed table to MS Excel
Financial Parameters

The Financial Parameters screen is used to enter various financial and operational information as follows:

Days Payable - Purchases

Enter the terms of payment to suppliers for goods, not including salaries or equipment. This parameter will influence your cash flow. For example, if you pay your supplier 30 days after you receive an invoice, enter 30.

Days Payable - Salaries

Enter the terms of payment for salaries. For example, if you pay employees every two weeks, enter 15. If you pay employees on a monthly basis but the payment is not made until the 15th of the following month, you should enter 0.
Days Payable - Capital Equipment

Enter the terms of payment for facilities and equipment. For example, if your payments are due 30 days after the delivery of the equipment, enter 30.

Inventory Level (Days)

Given normal sales, enter the number of days your Inventory can last. For example, if your Stock is worth $50,000 and your yearly cost of sales is $600,000, your average Stock level equals one month of sales.

( Note: If you're a manufacturer, don't forget to calculate for raw materials and work in progress.

Business Planner calculates the stock level in each period, and then includes it in the balance sheet. For example, if you enter 60 stock days in April, Business Planner divides 60 by the number of days in April (30) to come up with 2. It then multiplies the cost of goods and services for April by 2.
The stock increase or decrease influences the purchase figures in the Cash Flow report.

Inventory Amount

Enter the minimum required inventory amount. This amount will be added to the inventory calculated by days as mentioned above.

Pre-Paid Tax (%)

Enter the estimated taxes paid in advance. Enter this amount as a percentage of operating profit. While this does not include the tax deductibility of interest payments, it is a reasonable calculation.

Pre-Paid Tax (Amount)

If you don't enter pre-paid tax as a percentage of operating profit, enter the dollar amount of estimated taxes paid in advance.

Income Tax (%)

Enter the average tax rate paid by the company on its profit. This includes the Federal, State and Local tax rates. Calculate the average rate as the percentage of net profit before tax.

Interest Rate (%)

Credit: Enter the average annual interest rate for your bank deposit accounts.      Business Planner uses this rate for calculating interest income on cash balances.

Debit: Enter the average annual interest rate for your bank loans and overdrafts.  Business Planner uses this rate for calculating short-term loans required to meet cash shortfalls in the projections.
Product Pricing Trends (%)

Enter the rate of change you anticipate in pricing your products or services. Business Planner uses the change rate to make projections. For example, if the unit price of a product is $100 and you enter 10% as the rate of change in Product Pricing Trends for April, the price projections increase to $110. If you enter 10% as the rate of change for September as well, the price projections will then increase to $121.

Salary Trends (%) 

Enter the salary increase (as a percentage) you expect to make in a period. Business Planner applies this rate of change to figures for the previous period, as explained in the Product Pricing Trends above.

Product Cost Trends (%)

Enter the rate of change you anticipate in the costs of producing or handling your products or services. Business Planner applies this change rate to figures for the previous period, as explained in the Product Pricing Trends above.

Other Expenses

Enter any other expenses you expect, that are not part of the current production and operation expenses of the business (e.g. registration fees). These expenses will be calculated and presented in the Profit and Loss report after the Operational Profit.

Other Income

Enter any other income you expect from other sources, that is not part of the current income/sales of the business (e.g. profit derived from sales of fixed assets). This income will be calculated and presented in the Profit & Loss report after the operating profit.

Other Operating Income

Enter any other income you expect, that is part of the sales of the business but is not entered in the Sales Plan screen. This income will be calculated and presented in the Profit & Loss report in a different row under the sales row.

Average Salary in Production

Enter the average annual salary of production employee. The labor per unit, entered in the Product and Cost screen, will be multiplied by the units sold. The result will be divided by the average salary to calculate the number of production employees required in the plan. This figure is presented in the Financial Ratio screen.

Unrecoverable Debts (% of Sales)

The expected unrecoverable debts entered as a percentage of sales in each period.
Warranty (% of Sales)

The expected warranty expenses entered as a percentage of sales in each period.

Investments in Goodwill & Intangible Assets

Enter the projected investments in goodwill and intangible assets. These figures will be added to the projected balance and included as an investment in the projected cash flow report. 

Amortization of Goodwill & Intangible Assets

Enter the projected amount of Amortization (depreciation) of goodwill and intangible assets. These figures will be included in the the projected balance and the Profit and Loss report. 
Toolbar Buttons

All the tables include similar toolbar that appears at the top of the window and includes the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Print

Create a report for the current table, showing it on the print preview screen

Forecast

Copy cell value across next periods

Export to MS Excel file 

Exports the displayed table to MS Excel
Provisions

In the Provisions screen, enter the projected data of provisions that are planned to be made and paid during the plan period. 

The provisions include:

Pension provision

Salary and Benefits provision (which was not entered in the Operating Expenses’s Salary screens) 

Other Provisions (such as lost debt, unusable inventory, etc.)

Toolbar Buttons

The toolbar include the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Print

Create a report for the current table, showing it on the print preview screen

Forecast

Copy cell value across next periods

Export to MS Excel file 

Exports the displayed table to MS Excel
Capital Sources

The Capital Sources menu includes sub-menu items that enable you to plan the capital sources of the business and other financial activities:

Owner's Equity and Other

Owner's investments, dividends and other financial data.

Loan Table

Loan amortization table

Other Loans

Data for additional loans that is not entered in the Loan Table

These screens are detailed in the following sections.

Owners Equity

In Owner’s Equity screen you enter the following information:

Owner's Equity

Enter the amount the owners, partners, or investors plan to invest in the business during each plan period.

Dividends - Amount

Enter the cash dividend you expect to pay the owners during each plan period.

Dividends - %

If you plan to pay dividends as percentages of profits, enter the rate here for each plan period.

Credit Line

Enter the amount of the business credit line (you can also enter the amount of your overdraft line, revolver, or other short-term credit here instead). These figures are used in the Cash Flow report to measure variances from the approved credit.

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Print

Create a report for the current table, showing it on the print preview screen

Forecast

Copy cell value across next periods

Export to MS Excel file 

Exports the displayed table to MS Excel
Loan Table

The Loan Table enables you to enter information on long-term loans that the business intends to borrow. The software calculates the amortization table for each loan and includes its information in the projected financial reports.

For each loan the following information is entered:

Loan Name

A brief description of the loan

Principal

The total amount of the loan

Currency

The currency in which the loan is received and paid

Annual Interest Rate

The loan's annual percentage interest rate

Number of Payments in a Year

The number of payments each year. Usually a loan is paid in payments every month (12 payments per year), every three months (4 payments per year), every six months (2 payments per year) or once a year.

Total Number of Payments 

The total number of the loan’s payments. E.g. if the loan is paid back in 5 years with payment every month then the total number of payments will be 5 x12 = 60. 

Date Received

The date the loan is received

First Principal Payment

The date of the first payment that includes return of the principal of the loan or part of it. Usually the first principal date is the same as the first interest date, but in some types of loans, there is a grace period at the beginning of the loan period in which only the interest is paid.  

First Interest Date.

The date of the first interest payment. 

Payback Method

You have a choice of two types of loans:
Amortized Loan - Equal payments are made each payment date.

Fixed Principal - The principal amount is the same for each payment, but the interest amount decreases.

After you enter loan information, the loan amortization table is calculated automatically and presented below the Loan Table. The amortization table shows the loan payments and a total for each year, in a tree structure.

( Note: Do not duplicate information about these loans in the Other Loans screen.

Toolbar Buttons

All the tables include a similar toolbar that appears at the top of the window and includes the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Add

Add a line for a new loan after the last row

Insert

Insert a row for a new loan above the current row

Delete

Delete the current loan

Print

Create a report for the current loan, showing it on the print preview screen

Export to MS Excel file 

Exports the displayed table to MS Excel
Other Loans

Use the Other Loans screen to enter data for loans that were not entered in the Loan Table either because their payback data does not conform to the methods available for calculation in the Loan Table, or because you found it more convenient to enter the data here, e.g. in case the schedule and amounts of the loan payback is already prepared and you don’t have to calculate the amortization table.

The screen includes up to 5 loans, each with 3 lines as follows:

Loans Received

Enter the description of the loan in the first column and then the amount of the loan in the period when it is expected to be received.

Principal Payments

Enter the amount of the principal payment for the loan in each period, not including interest. 

Interest Payments

Enter the amount of interest paid per period for the loan. 

Currency

For each loan, you can choose the currency from a drop down list, by which the loan is received and paid. The amounts will be translated to the analysis currency by the exchange rate specified in the Currency Table.

Toolbar Buttons

All the tables include similar toolbar that appears at the top of the window and includes the following buttons: 

OK

Close screen and save all data entered

Cancel

Close screen without saving the data

Print

Create a report for the current table, showing it on the print preview screen

Forecast

Copy cell value across next periods

Export to MS Excel file 

Exports the displayed table to MS Excel
Downpayments

The Downpayments screen enables you to enter data about payments that are paid in advance before the actual sale takes place. The downpayments are reflected in the projected cash flow of the business.
The screen allows entering data for up to 50 projects, a "project" being a name for a certain activity for which downpayments are paid. 
Each project has two lines. In the first line the description appears in yellow and you can change it to the name that matches the activity for which you want to enter the payments. In this line, in the periods cells, you enter the projected amounts that will be received as downpayments.
In the second line of each project you enter the amounts of the sales for which downpayments were received. Usually the amounts should match the total amounts of the downpayments, but they will be entered in the periods in which the sales were entered in the Sales Plan screen.
 Example
Suppose that you have one sale of 100,000 Euro which is scheduled for July 2005. You enter this sale in the Sales Plan screen (e.g. define one product in the Products table, save the Products table, then open the Sales Plan screen, enter unit price of 1 Euro and enter 100,000 units in July 2005).
The result of this data entry will appear in the Profit and Loss report in July 2005 as sales of 100,000 Euro and in the Cash flow report there will be a cash receipt of the same amount in the same month.
Now assume that the agreement with the customer is that 60% of the sale amount will be received in advance in six monthly payments starting from January 2005. 
In this case you should enter, in the Downpayments screen, receipts of 10,000 Euro in each of the months from January till June 2005, and in July 2005 you enter, in the second line, the total amount of payments that were received on account of this sale.
As a result of this data, the Cash flow report will show receipts of the downpayments in the first six months and then the rest of the sale amount in the seventh month.
In the Balance report the downpayments will appear as liabilities to Other Payables until the sale takes place.
Toolbar Buttons
The toolbar includes the following buttons: 
OK
Close screen (and save all changes if applicable)
Exit
Close screen and discard any changes if applicable.
Print Table
Create a report for the current table, showing it on the print preview screen
Copy across

Copy cell values across next periods
Export to MS Excel file 

Exports the displayed table to MS Excel
Actual Data

The Actual Data module is used to enter data of the actual performance of the business during the plan period. When the actual data is entered, it is used to produce Actual versus Plan Analysis.
The actual data is entered in the following screens:

Profit and Loss
Actual Profit and Loss statement

Cash Flow

Actual Operating Cash Flow statement

Balance
Actual balance sheet

Plant and Equipment
Actual investments in plant and equipment

Profit Centers
Actual sales per market per product

Revenue/Sales
Actual sales amount per market per product

Operating Expenses
Actual Operating and Salary expenses

These screens are explained in more details in the following pages.

( Note: Year Total Columns - When entering data in the Actual Data screens you will see a total year column that sums up the data that is entered for this year by months or quarters. This column is shown if the parameter "Show Year Total columns in data screens" in the Preferences screens is marked. 

( Note: In the Actual Balance screen the total year column will show the same figures as the last month or quarter, and not the sum of the months or quarters of course. 

Toolbar Buttons
All the tables include similar toolbar that appears at the top of the window and includes the following buttons: 

OK
Close screen (and save all changes if applicable)

 

Exit
Close screen and discard any changes if applicable.

 

Print Table
Create a report for the current table, showing it on the print preview screen

 

Forecast
Copy cell values across next periods

 

Export to MS Excel file
Exports the displayed table to MS Excel

 

Actual Profit and Loss

The Actual Profit and Loss screen is used to enter the actual Profit and Loss Report information for the plan period in order to use it for the Actual vs. Plan Analysis. While you enter data the subtotals and totals of the Profit and Loss are calculated automatically. 

The Profit and Loss items are explained in more details in the Analysis Profit and Loss screen explanation.
Actual Cash Flow

The Actual Cash Flow screen is used to enter the actual Cash Flow transactions that occurred during the actual period. This data is used for the Actual vs. Plan Analysis and also for the Forecast analysis. While you enter data the subtotals and totals of the Cash Flow are calculated automatically.  

The Cash Flow items are explained in more details in the Operating Cash Flow screen explanation in the Analysis chapter. 
Actual Balance

The Actual Balance is used to enter the Actual Balance Sheet information for the plan periods. While you enter data the subtotals and totals of the balance are calculated automatically. 

( Note: For each of the periods the Total Assets should equal Total Equity and Liabilities, otherwise you will not be able to save and close the screen. 
( Note: the accumulated depreciation is entered as a negative figure.
The Balance items are explained in more details in the Analysis Balance screen explanation.

Actual Plant and Equipment

The Actual Plant & Equipment screen is used to enter the actual investments that were done in the plan period in plant and equipment.

The screen is loaded with the same items that were entered in the Plant and Equipment screen and you can’t edit, add or delete these items here. 

In case you want to add an item, you should close this screen, load the Plant and Equipment screen (where the plan items were defined), add the item there and save it. Then re-load the Actual Plant and Equipment screen again and the item will appear. 

Actual Profit Centers

The Actual Profit Centers screen is used to enter the actual income and expenses for a profit center. A profit center in the software is defined as a market which was entered in the Market table. Select the profit center from the list and then enter the actual data. Once you entered the actual data for a profit center, you will be able to view an Actual vs. Plan analysis for this profit center in the Analysis section.  

Actual Revenue/Sales

The Actual Revenue/Sales screen is used to enter the actual sales per product in each market. These values are then used in the Actual vs. Plan Sales analysis to compare the planned revenues to the actual sales.

Actual Operating Expenses

The Actual Operating Expenses screen is used to enter the actual operating expenses and salaries that were done during the plan period.

The screen is arranged in the same structure as the Operating Expenses screen that is used for planning. The Department list appears at the left and the screen includes the same three sections as the Operating Expenses screen: Fixed Expenses, Variable Expenses and Salary & Staff. You can switch between these sections by clicking the buttons on the toolbar.

Each section is loaded with the same items that were entered in the Operating Expenses screen. You can’t edit, add or delete these items here. In case you want to add an item, you should close this screen, load the Operating Expenses screen (where the plan items were defined), add the item there and save it. Then re-load the Actual Operating Expenses screen again and the item will appear. 

Analysis Menu

The Analysis options enable you to view and analyze the results of the plan. These options include:

Highlights

View the highlights of the plan results

Profit & Loss

Review the projected Profit and Loss statement based on the data you entered

Operating Cash Flow

View the projected operating cash flow

Cash Flow Statement

View the projected cash flow statement

Balance

View the projected pro-forma balance sheet

Valuation

Analyze the value of the company and it's Economic Value Added (EVA)
Financial Analysis

Analyze the Rating, Financial Ratios and Survival Ratio of the business
Break Even

View the Break-Even point of the plan and evaluate the risk involved

What If

Analyze how changes in basic assumptions influence your plan

Goal Seek

The Goal Seek analysis assists you in finding the parameters for achieving a certain target profit

Indicators

View the main financial indicators of the plan

ROA/ROE Analysis

Analyze the return on assets and equity

Profit Centers

View the profitability of the business profit centers

Operating Expenses

View the expenses for each department calculated to the analysis currency
Sales Analysis

The Sales Analysis screen displays the sales that are planned for the plan periods

Actual vs. Plan

View a comparison of the actual performance of the business to the plan

Forecast

The Forecast module is meant to show the expected performance of the business till the end of the current year.
( Note: The software is always aware if projected data has been changed and will perform a calculation before displaying any analysis, screen, report or graph. 
Highlights

The Highlights screen shows the main results of your business plan by periods. The columns in the table are:

Revenues

Sales revenues forecast for each period.

Net Profit

Net Profit after tax.

Net Profit (%)

Net Profit as percentage of Revenues.

Operating Profit

Profit before tax and interest expenses.

Bank Balance

The projected bank balance at the end of each period. This includes the cash and the short-term borrowings in the Balance sheet.

The Highlights Graph shows the trend of the sales and net profit during the plan years.

Toolbar Buttons

All the tables include similar toolbar that appears at the top of the window and includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Options

Arrange the screen in another arrangement

Export to MS Excel file 

Exports the displayed table to MS Excel
Profit and Loss

This screen presents the projected Profit & Loss report for the plan period. 

The purpose of the Profit and Loss Report, sometimes referred to as Income Statement, is to show the activity and profitability of the business for a specific period, by showing the income and expenses that refer to this period. The Profit and Loss shows, in many cases, a different and even contradicting presentation of the business state compared to the Cash Flow report. A business can be very profitable but suffer from lack of cash, or it can suffer from losses but have enough cash to survive. In the long range, such a contradiction would be solved. A profitable business will manage to accumulate or borrow the required cash while a business with continuing losses will consume all its reserved cash.

The Profit and Loss report can be presented in one of two methods according to the selection you have made in the System Options screen under File menu: the Total Cost method or the Direct Cost method. 

These methods are different from each other mainly in the way the costs are presented.

In the Direct Cost method, the cost of the products or services that is included in the P&L reflects only the cost of the products that were sold during the period of the report.

In the Total Cost method, the cost of the products or services includes all the expenses spent for production during the period of the report, including cost of materials and labor for products that are still in inventory and were not sold. In this method the Income (production) of the company includes both sales and change in inventory, while in the Direct Cost method, the income includes only sales.

The Profit and Loss items are as follows:

Total Cost method

Revenues

The total sales revenues in each period.

Inventory Change

The change in inventory that was made in the plan period.

Other Operating Income

Income that was entered in the Financial Parameters screen and includes specific income that is not part of the usual Sales Plan of the business.

Total Production

The sum of revenues and inventory change.

Direct Cost

Materials, labor and other costs consumed in the production according to unit cost, including inventory production.

Gross Profit

The Gross Profit of production, i.e. Total Production less Direct Production Costs. 

Depreciation

The total depreciation of fixed assets for the period. Business Planner uses the straight-line depreciation method.

Operating Expenses

Operating expenses entered in the Operating Expenses screens not including Salary. 

Unrecoverable Debts

Debts of customers that can’t be collected are regarded as an expense. The debts are calculated as a percentage of sales according to the data entered in the Financial Parameters screen.

Provisions

Provision done for lost debts, unusable inventory, etc. They are entered in the Provisions screen as other provisions.

Salary

The salary and benefit expenses, including salary data entered in the Operating Expenses screens and Provisions for Pensions and benefits, entered in the Provisions screen.

Amortization of Goodwill & Intangible Assets

Amortization (Depreciation) of goodwill and intangible assets. These figures were entered in the Financial parameters screen. 

Operating Profit (EBIT)

Profit from operations before interest, taxes, and other expenses. Sometimes referred to as EBIT (Earnings Before Interest and Taxes).

Interest Income

Usually caused by a credit situation, a positive cash flow for example.

Interest Expenses

Total financial costs from borrowed funds during the period. This would include fees for loans and interest payments.

Total Finance 

The sum of Financial Income less Financial Expenses.

Other Income

This item includes profit-producing activities that are not related to the principal business activity (e.g. profit from sales of fixed assets).

Other Expenses

This item includes costs that are not incurred primarily for the purpose of generating revenue.

Total Others

The sum of Other Income less Other Expenses

Income Before Taxes

The profit before tax.

Income Tax Provision

The tax provision is calculated as a percentage of income before tax.

Net Profit

The profit after tax provision.

Dividends

The dividends that share holders will receive during the plan period. 

Retained Earnings Provision

The part of the earnings that is allocated for specific targets, such as renewal of old equipment.

Provision Profit

The net profit that will be accumulated to the unallocated retained earnings of the business, as presented in the Balance 

Direct Cost method

In this method most of the items are similar to the Total Cost method except for the following items:

Direct Cost

Materials, labor and other costs consumed in the production according to unit cost, including only costs of units that were sold.

Operating Expenses

Operating expenses entered in the Operating Expenses screens, including Salary.

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Years

Display years only or all the periods

Percentage Columns

Display percentage columns next to the amount columns

Percentage base

Enables selection of the percentage base between Revenues and Gross Profit 

Export to MS Excel file 

Exports the displayed table to MS Excel
Operating Cash Flow

In this screen you can view the projected Operating Cash Flow of the business. 

In many cases, the cash flow is the main concern of the business owners and managers because lack of cash is the main reason for business failure, especially when the business is new. 

The Cash Flow report includes the cash that flows into the business from the operational and financial activities and the cash that is used for these activities. Each period starts from an opening bank balance and ends with the closing bank balance that reflects the cash that was added to the bank balance and the cash that was used. 

Negative bank balance indicates that the business requires external funding, since its activities are not sufficient to finance it.

The cash flow report also includes a section that shows the status of the accumulated cash against the Credit Line that the bank has installed for the business. A deficit in funds will require the business to find other sources for funding.

Another section shows the Sales Tax payments and returns. 

While this screen shows the cash flow from the operational point of view, the Cash Flow Statement screen presents a more accounting presentation of the Cash Flow sources and applications but both screens present the same picture in a different way. 

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Years

Display years only or all the periods
Percentage Columns

Display percentage columns next to the amount columns

Export to MS Excel file 

Exports the displayed table to MS Excel
Cash Flow Statement

In this screen you can view the projected Cash Flow presented in an accounting presentation. 

The Cash Flow Statement presents, in different sections, the cash that was created by the business operations, the changes in operating Assets and Liabilities, the investments in Plant and Equipment and the cash flow generated by or used for financial activities.

Negative cash flow indicates that the business requires external funding, since its activities are not sufficient to finance it.

While this screen shows the cash flow from the accounting point of view, the Cash Flow Statement screen presents a more operational presentation of the Cash Flow sources and applications but both screens present the same picture using a different perspective. 

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Years

Display years only or all the periods
Export to MS Excel file 

Exports the displayed table to MS Excel
Balance

The projected Balance Sheet shows the status of the business at the end of each plan period and presents the assets that the business owns compared to the liabilities that it owes to external parties and the owners equity and retained earnings.

Unlike the Profit and Loss and the Cash Flow reports that present what happened during a period, the balance presents the situation that is true for a specific point in time. The Balance report is important for managers and analysts that want to analyze the way the business is funded, its financial stability and level of liquidity.

The Balance can be viewed in a table structure that is its regular presentation and in a tree structure that can be collapsed or expanded to show different levels of the balance items. You can switch between the two views by using the buttons on the toolbar as explained below. 

The Balance Sheet splits into two balancing sides that include the following items:

Fixed Assets

Land, Plant and Equipment owned by the business.

New Investments

Investment in plant and equipment, done during this period.

Depreciation

Depreciation calculated on fixed assets.

Goodwill & Intangible Assets

Net value of goodwill and intangible assets after amortization. These figures were entered in the Financial parameters screen. 

Inventory

Inventory of material, in-process and finished goods.

Accounts Receivable

Debts of customers and other Accounts Receivable to the business.

Other Receivables

Amounts for Sales Tax and Tax rebate to receive from the tax authorities.

Cash

Cash and Cash Equivalent assets that the business owns.

Total Assets

Sum of the above assets.

Owners Equity

Equity invested by the owners of the business.

Profit Provision

Profit allocated for specific use such as renewal of old equipment.

Retained Earnings

Accumulated profit or loss of the business in the previous years less paid dividends.

Profit/Loss T/Y

Profit or Loss this year (or period)

Total Equity

Sum of the above equity, profit and earnings items 

Pension Provisions

Provisions done for Pensions

Other Provisions

Provisions done for long term expected expenses (e.g. renewed equipment purchase)

Long Term Liabilities

Long-term loans.

Total LT Liabilities

Sum of the above provisions and liabilities

Short Term Liabilities

Short terms loans and bank overdraft.

Account Payable

Debts to suppliers and employees.

Other Payables

Debts to Other Accounts Payable.

Sales Tax and Tax Payable

Debts to Sales Tax and tax authorities

Salary and Benefits

Provisions to various salary and benefits to be paid in the short term.

Total Current Liabilities

Sum of the above short term liabilities and 

Total Equity and Liabilities

Sum of the above Liabilities and Owners Equity.

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Years

Display years only or all the periods

Percentage Columns

Display percentage columns next to the amount columns for each period

Table/Tree View

Change the display of the balance from table to a tree view and vice versa

Expand/Collapse Tree

If the Balance is displayed in a tree structure then this button will expand or collapse the tree items that are in different levels, so that all items will be seen or just items from the same level and up.

Export to MS Excel file 

Exports the displayed table to MS Excel
Valuation

The Valuation analysis is done when there is a need for an external funding, or in case you want to buy or sell the business.  Based on the valuation, you can decide what is the part of the business shares that you are willing to give to the investor for a certain amount of investment. A value analysis which is done on a periodical basis is also important to measure the success of the management. If the manager has succeeded to increase the value of the business, this may be more significant for the shareholders than the profit the business has created.  

It is important to stress that business valuation is not an accurate measurement, especially if we base it on the business potential and future achievements.  Usually the valuation results will be used as a basis for the negotiations between the owner and the investor. The final value of the business will be influenced by many other factors such as the benefit each side will derive from the investment, the objectives of each side, the business goodwill and management, the level of control that each shareholder will have over the business operations, etc.

The Valuation module offers two commonly used methods to evaluate the company’s worth. 

Free Cash Flow

In this method the value of a business is based on the future free cash that it will generate

Price / Earnings

A company’s value under this approach is based on the assumption that the company value should be similar to companies whose shares are traded in the stock market.

EVA Analysis

Analyze the Economic Value Added

These three methods are explained in more details in the following sections.

Free Cash Flow

The Free Cash Flow method is the most widely accepted valuation method, particularly for evaluating an on-going concern. The method is based on measuring the business opportunities in the future and its projected cash flows. Both are crucial to the investors and shareholders.

The Formula  

[image: image3.png]Net Free Cash Flow =





Where:

FC 
= Free Cash Flow in Year i

n 
= The Forecast Period in Years

r
= Discount Rate

RV
= Residual Value in Year n

ADJ
 = Adjustments: Surplus assets less Debts 

Operating Steps

Step 1

Enter the Discount Rate. This rate is based on the free risk interest rate in the market (e.g. government bonds) with a Market Risk Premium which grow as much as the risk which is involved in the business, or as much as the uncertainty in the business, its products and markets.

If you are not familiar with selecting the right discount rate, it is recommended to use 12-15% rate for a low risk business and 25-40% for a high-risk business.

Professionals use the Weighted Average Cost of Capital (WACC) calculated by the following formula:
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Where: 

T
= Marginal Tax Rate

CD
= Cost of Debt (The average interest rate on the company’s debt)

CE
= Risk Free Interest  + (Beta * Market Risk Premium)

Beta
= Risk factor of the business compared to the average risk in its industry. A Beta that is lower than 1 means that the business is less risky than similar businesses in its industry and vice versa.

Step 2

Enter the Price/Earnings factor. The factor should be selected according to the average Price/Earnings factor of public companies that belong to the same industry that your business belongs to. This data can be accessed every day from the financial section in almost every daily newspaper.

Step 3

Enter the amount of Surplus Assets (assets that the business can sell without hurting its current operations) and the amount of Debt Value (short and long term debts that the business owes).

Step 4

View the Company Value in three residual value methods. These methods are explained below. 

( Note the company value is calculated based on the accumulated discounted cash flow during the plan period, added with the discounted residual value and the surplus assets, less the debt value.

Residual Value Methods

The three main methods to measure the residual value, which is calculated as part of the Free Cash Flow method, are as follows:

1. The Perpetuity Method

The perpetuity method assumes that the company’s future cash flow will continue forever. The residual value of the business is calculated according to the following formula:
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Where:

r
=  Discount Rate

n          = The last year of the analysis period

( Notes 

1.Some analysts suggest using the operating profit instead of the free cash 

   flow in the formula.

2.Some analysts use a different (higher) perpetuity discount rate as opposed 

   to the free cash flow discount rate, assuming that the uncertainty grows in 

   future period that is far from the plan period.

3.Some analysts include growth rate in the formula assuming that the 

   business will continue to grow. They do it by multiplying the free cash flow   

   of the last year by the growth factor, and reducing the  growth rate from the 

   discount rate.

4.The software does not support the above methods and they are described 

    for your information.

2. The Liquidation Method

This method assumes that the most conservative way to calculate residual value is to assume that the firm will be liquidated at the end of the forecasting period. Therefore the residual value should be calculated as the net liquidation value – the assets value (including cash, account receivable, inventory, plant and equipment) less liabilities value (including accounts payable, short and long term liabilities). This value that is calculated for the end of the forecasting period is discounted for the beginning of the period before adding it to the discounted cash flow, in order to calculate the company value.

3. The Price Earnings Method

This method assumes that the best way to determine a company’s residual value is to calculate its market price using the relevant Price Earning factor.

 The Formula
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Where :

Comparative P/E
= P/E  of any similar public company or industry  average 

r 


= The discount rate

n 


= The selected year

The residual value calculated by this formula is discounted to the beginning of the plan period and is added to the discounted cash flow.

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Export to MS Excel file 

Exports the displayed table to MS Excel
Price/Earnings

A company’s value under the Price/Earnings approach is based on the assumption that the company value should be similar to companies whose shares are traded in the stock market. The company’s value is calculated according to the future profit of the business and the industry average P/E ratio or the P/E ratio of another firm with a similar business profile.

The Formula
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Where:

Profit in Year i
= Net profit in any chosen year (I)

Comparative P/E
= P/E  of any public company or industry average 

r


= Discount Rate

This Value is discounted to the beginning of the forecast period.

Operating Steps

Step 1

Enter the PE factor – the average PE of the industry or the PE of a similar company. If the PE is unavailable or is high due to seasonal high rates in the stock market, it is recommended to use a PE of 7-12.

Step 2

Enter the discount rate. This rate is based on the free risk interest rate in the market (e.g. government bonds) with a Market Risk Premium which grow as much as the risk which is involved in the business, or as much as the uncertainty in the business, its products and its markets.

Step 3

View the company value as it varies during the plan period.

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Options

Arrange the screen in different arrangements: display table with graph or just one of them.

Export to MS Excel file 

Exports the displayed table to MS Excel
EVA Analysis

The EVA screen presents the analysis of the Economic Value Added, an advanced evaluation method that measures the performance and the profitability of the business, taking in account the cost of capital that the business employs. This method, invented by Stern Stewart & Co. , is used today by more and more companies as a framework for their financial management and their incentive compensation system for the managers and the employees.

The EVA is calculated by the following formula:
 

EVA =  NP -  TC *   WACC

 

Where:

NP = Net Operating Profit after Tax
TC = Total Capital Employed = Total Equity and Liabilities of the Company
WACC = Weighted Average Cost of Capital
The Weighted Average Cost of Capital (WACC) is calculated as follows:

WACC = (E * CE% + SL * CS% + LL * CL%) / TC

Where:

E = Owners Equity

CE% = Average cost of Owners Equity

SL = Short Term Liabilities

CS% = Average cost of Short Term Liabilities

LL = Long Term Liabilities

CL% = Average cost of Long Term Liabilities

 

The net present value of EVA is calculated according to the Discount Rate as follows:

 NPV  EVA =  Σ ( EVAi / (1+ r)^i )  +  EVAn / r

Where:

EVAi = EVA calculated for year i

r = Discount Rate

n = the last year of the plan period

 

Operating Steps

Enter the average cost of capital for the equity, the long term libilities and the short term liabilities, then enter the discount rate. The values of the EVA will be calculated and presented. Please note that when you enter data into the average cost cells, the values are copied to the following years IF the cells for these years are empty. 

Toolbar Buttons
All the tables include similar toolbar that appears at the top of the window and includes the following buttons: 

OK
Close screen (and save all changes if applicable)
Print Table
Create a report for the current table, showing it on the print preview screen
Display Options
Arrange the screen in different arrangements: display table with graph or just one of them.

Export to MS Excel file 

Exports the displayed table to MS Excel
 

( Note: EVA® is a registered trademark of Stern Stewart & Co
.

Financial Analysis

Rating Module

Evaluate the Rating of the Business

Financial Ratios

Evaluate the plan's validity and view key financial ratios

Rating Ratios

Analyze the financial performance and the survival ratio for your business
These three methods are explained in more details in the following sections.

Rating module (Pro version only)
This Rating Module enables you to evaluate the rating of your business in a method similar to the methods that are used by banks and financial institues to rate businesses. By using the Rating Module you will have the possibility to get the idea how they are going to evaluate your business and how you can improve your rating.

The Rating process includes three steps:

Step 1. Qualitative Analysis
This section will present you with a series of questions where you are asked to grade different aspects of the business situation and management performance. Each aspect can be graded by using the drop down list to the right of the questions and selecting the answer that most closely describes your performance. 

The grades are between 1 (Very Good) and 6 (Insifficient). 

On the left side of the screen you can see the Rating steps. Move from step to step by clicking the 'Next' button or by clicking the next item on the list.

Step 2. Quantitative Analysis - Ratio Analysis
The Ratio Analysis presents financial ratios that are commonly used for Rating. For each ratio the value for each year of the plan is calculated, based on the data that is presented in the Anlysis screens - the Profit and Loss, the Balance and the Cash Flow. 

Then, each ratio value is graded between 1 (Very Good) and 6 (Insifficient) according to pre-defined grade levels that can be changed in the Setup screen as explained below. 

Step 3. The Rating
The Rating result is displayed in the last screen. It shows the results of the Qualitative Analsysis and the Quantitative Analysis both combined to give a final Rating result for each of the plan years.  The weight of the two analyses in the final result is by default 50% for each, but it can be changed in the Setup screen as explained below. 

The Setup Screen
The Setup screen can be loaded by clicking the 'Setup' button which is visible in the Ratio Analysis screen.  

In the Setup screen you can change the pre-defined grade levels in for each ratio. You should define the Sign, greater (>) or smaller (<), of the ratio when it is measured against the levels because for some ratios higher value is better and for others higher value is worst.

The Setup screen also enables you to enter the weight given to Qualitative Analysis vs. Quantitative Analysis. These Weight are used to calculate the final results of the Rating.

Financial Ratios

The Financial Ratios screen presents various profitability, liquidity, stability and operational ratios that the software has calculated. These ratios help analysts to evaluate the validity of the plan and to compare the projected performance to other businesses on a common base.

If you have checked the 'Show previous periods' option in the Preferences screen (General Parameters tab) and the plan includes previous years (as defined in the General Data screen) then the Financial Ratios screen will display data for previous years in columns that will appear before the first plan period.

The financial ratios and formulas are as follows:

Net Profit / Revenues (%)
Net Profit / Sales * 100

Operating Profit / Revenues (%)
Operating profit / Sales *100

Net Profit / Assets (%)
Net Profit / Assets * 100

Operating Profit / Assets (%)
Operating profit / Assets *100

Net Profit / Equity (%)
Net Profit / Equity * 100

Operating Profit / Equity (%)
Operating profit / Equity *100

Current Ratio (%)
Current Assets / Current Liabilities * 100

Quick Ratio (%)
(Current Assets - Inventory) / Current Liabilities * 100

Financial Leverage
Liabilities / Equity

Equity / Assets (%)
Equity / Assets * 100

Liabilities / Assets (%)
Liabilities / Assets * 100

EBIT + Interest / Interest (%)
(Earning before Interest and Tax + Interest / Interest) * 100

L. T. Debt / Assets (%)
Long Term Liabilities / Total Assets * 100

S.T. Liabilities / Assets (%)
Short Term Liabilities / Total Assets * 100

Cash / S.T. Liabilities (%)
Cash / Current Liabilities  * 100 

Working Capital / Revenues (%)
(Current Assets - Current Liabilities) / Revenues * 100

Working Capital / Assets (%)
(Current Assets - Current Liabilities) / Assets * 100

Growth Rate - Revenues (%)
(This Period Revenues-Previous Period Revenues)/(Previous Period Revenues)*100

Growth Rate - Net Operating Profit (%)
(This Period Op. Profit-Previous Period Op. Profit)/(Previous Period Op. Profit) * 100

Day's Sales Outstanding
(Acc. Receivable / Revenues * 360) if the period is a year; or * 30 if the period is a month or * 90 if the period is Quarter.

Days Payable
(Acc. Payable / Purchases * 360) if the period is a year; or * 30 if the period is a month or * 90 if the period is Quarter. Purchase includes all expenses and changes in inventory.

Days Inventory
(Inventory / Direct Costs * 360)

Net Operating Cash Flow
The operating cash that the business creates or needs every period includes the Cash that is received from sales less the cash that is paid for expenses, salaries and investments in plant and equipment. Financial transactions such as owners investments, loan received and loan paid are not taken in account. The values in this line is used to calculate the Present Value in the next line.

P. V.
The Present Value of the Net Operating Cash Flow for each period. It is calculated by the discount rate that is entered in the General Data screen according to the usual discount method where each value for each period is divided by the discount rate factor that matches its period (e.g. the value for the third year is divided by the discount rate powered by 3 which is (1+R) ^3 ). 

N. P. V. (Acc)
The Accumulated Net Present Value sums the values of the above mentioned Present Value row to give the accumulated result  for each period.

( Note: the Present Value lines will be displayed only if the Discount Rate in the General Data screen was entered. 
Toolbar Buttons
The toolbar includes the following buttons: 
OK
Close screen (and save all changes if applicable)

 

Print Table
Create a report for the current table, showing it on the print preview screen

 

Display Years Only
Display years only or all the periods

 

Export to MS Excel file
Exports the displayed table to MS Excel

 

Survival ratio
This screen presents a number of ratios that are used by financial institutes for the rating of businesses and for the decision making concerning their credit terms. The ratios and their formulas are explained in more details in the German help and in the User's Manual.

If Previous Periods have been defined in the General screen, then they are displayed here before the first plan period.

The screen is also used to display the Survival Ratio (based on the Altman’s Z Score model) which is one of the most reliable ratios for analyzing the business ability to remain an on- going concern. The Survival Ratio ranks the business short-term stability as follows:

Unstable (Red) - The business is unstable. There is serious doubt if it will remain an on-going concern for long. Range: Bellow 1.23

Stable (Black) - The business is OK. There is no indication of a financial catastrophe in the near future. Range: Above 1.23 Bellow 2.90
High Stability (Green) - The business’s financial state is very stable (usually above the industry averages). Range: Above 2.90

( Note: You can edit the default ranges changing it according to your requirements. 
The Formula

Survival Ratio = 3.107[A] + 0.847[B] + 0.420[C] + 0.717[D] + 0.998[E]

Where:
A = [Op. Profit/ Assets]

B = [Retained Earnings / Assets] 

C = [Equity / Debt]

D = [Working Capital / Assets]

E = [Revenues / Assets]

The screen shows the above ratios that are used to calculate the survival ratio and the survival ratio itself.

Toolbar Buttons
The toolbar includes the following buttons: 

OK - Close screen (and save all changes if applicable)

 

Print Table - Create a report for the current table, showing it on the print preview screen

 

Display Options - Arrange the screen in different arrangements: display table with graph or just one of them.

 

Export to MS Excel file - Exports the displayed table to MS Excel
 

Break Even

The Break Even analysis presents the opportunities and risks of your business. The Break-Even point is the minimum sales quantity or sales amount that covers your operating expenses. Each point below the break-even point reflects the operating loss; each point above reflects the operating profit.

The Break-Even formulas are:

Revenue at Break-Even = Fixed Expenses + Variable Expenses

Quantity at Break-Even = Fixed Expenses / (Unit Price - Unit Variable Cost)

( Notes:
· In the formula above, adjust Variable Expenses for unit price and variable costs.
· Business Planner analyzes the quantity or dollar amount needed for Break-Even in percentage increments of forecast revenue beginning with 10%. If your plan is profitable at 10% of projected revenue, Business Planner generates the report, but does not show a break-even point.

Click the period dropdown list and select the period for which you want to view the break-even analysis. 

The Break Even columns are explained below.

Sales

The revenues in the analyzed period 

Fixed Expenses

The fixed expenses include expenses entered in the Operating Expenses screen in the fixed expenses section and in the salary and staff section.

Variable Expenses

The variables expenses include direct costs of the sold products or services and expenses entered the Operating Expenses screen in the Variable Expenses section.

Operating Profit

The Sales (Revenues) less fixed and variable expenses.

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Options

Arrange the screen in different arrangements: display table with graph or just one of them.

Export to MS Excel file 

Exports the displayed table to MS Excel

What-If Analysis
The What-If screen enables you to carry out on-line analyses that show how changes in factors such as price, quantity, and expenses influence your plan.

The What-If is a crucial decision making tool that provides a real picture of the uncertainty and risks inherent in the business. This analysis enables you to reduce the uncertainty, that is a part and a goal of any business planning.

Two types of What-if analysis are available:

One Way
Shows the influence of a change of one key parameter on the main business results.

Two Way
Shows the influence changes in two key parameters on the Operating Profit. 

To perform the What-If analysis:
1. Select the type of analysis you want to use by clicking the buttons on the toolbar.

2. Select the key parameter you want to change. For example, select Price to see what influence changing prices would have on your plan. In the Two-Way analysis select two parameters.

3. Select the range of change. For example, to raise prices by thirty percent, select +30%. In the Two-Way analysis set the range of change of the second factor as well.

4. Select the period of the analysis (First year or the whole plan period). In the Two-Way analysis select if you want to see the results of the operating profit as a percentage of revenues or as an amount. 

5. View the analysis results

What-If (Simulation) by Years (Pro version only)
The What-If analysis can be run for each of the plan years (while in the previous version only the first year could be selected). The analysis can be run also for the whole plan period. 

In both of the What-If methods, the One-Way or the Two-Way, the period for the analysis can be selected from a list that contains the plan years and All Periods. The values used for the What-If will be for the selected period.

Toolbar Buttons

The toolbar includes the following buttons: 

OK
Close screen (and save all changes if applicable)

Print Table
Create a report for the current table, showing it on the print preview screen

Export to MS Excel file
Exports the displayed table to MS Excel

One Way
Displays the One-Way What-If analysis
Two Ways
Displays the Two-Ways What-If analysis

Goal Seek (Pro version only)
The Goal Seek analysis assists you in finding what should be the sales, or the direct costs or the operating expenses, in order to achieve a certain target profit.  
The Goal Seek works in a similar way to the What-If analysis but from another point of view. While the What-If measures what will be the operating profit if a key parameter (such as sales or unit cost) will change, the Goal Seek finds how much should a key parameter change (increase or decrease) in order to create a required profit.
Select the Goal Seek option from the Analysis menu to load the screen. Use the Goal Seek function as follows:
1. Select the Key Parameter that should change in order to achieve the target profit. Three parameters are available: Sales, Unit Cost and Operating Expenses.
2. Enter the Target Operating Profit (in % of sales)
3. Select the period for which the analysis is run.
4. The results will be shown in the table. The Plan results will be displayed in the second column and the target results, the Goal, will be displayed in the fourth column. Next to each column a percentage column is displayed showing the percentage of sales for each value. 
The calculation of the Goal Seek is simple. When the key parameter is Sales, the sales will be increased or decreased, the direct costs and the variable operating expenses will increase or decrease respectively with the sales, and the operating profit will be recalculated in each step, until it reaches the required percentage of sales. 
When the key parameter is Unit Cost, the Direct Costs will be increased or decreased, and the operating profit will be recalculated until the target is achieved. A similar calculation is done when the key parameter is the Operating Expenses.    
No Solution
If there is not a valid solution the target results column will be empty and a message "No Solution" will be displayed.  The cases in which no solution occurs are, for example, when the key parameter is the Operating Expenses and even if operating expenses are decreased to zero the operating profit will not be as required.
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The toolbar includes the following buttons: 
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Indicators

The Indicators screen presents financial indicators which are important to analyze the validity and profitability of the business plan. These indicators are calculated for the entire planning period and include:

Total Revenues

The total revenues during the plan period.

Net Present Value (NPV)

The discounted amount of the net operating cash flow during the plan period. This value is based on the assumption that amount of income or expenditure received or paid in the future is not equal to the same amount as of today due to the cost of capital. Future amounts are discounted to the beginning of the plan period by the discount rate which was entered in the General Data screen.

Internal Rate of Return (IRR)

The discount rate that sums up the Net Present Value to zero is the IRR. This rate represents the return rate of the business in terms of percentage and is used to compare the business against other investment alternatives.

Payback Period

The period, in years, in which the investment in the business is returned. It is calculated based on the period where the accumulated NPV becomes positive. 

Maximum Exposure

The maximal amount that can be lost in the business if it is closed at the worst point, i.e. when the investment in plant, equipment and working capital is done and the revenues have not started or are too low to cover the investment. The formula of the Maximum Exposure is:

Retained Earnings – (Fixed Assets – Acc. Depreciation + Inventory)
The Indicators screen presents, in a table and in a graph, the change of the accumulated Net Present Value during the plan period.

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Export to MS Excel file 

Exports the displayed table to MS Excel
ROA/ROE Analysis

The Return On Equity (ROE) and the Return On Assets (ROA) analyses are measures of the business efficiency in using its resources (equity and assets).  

It is interesting to observe the trends in these ratios during the analysis period and how these changes relate to changes in the sub components that build the ratios.

The Formula

ROE = [Equity Turnover] * [Return on Sales]

Where:

Equity Turnover = Total Sales / Total Equity 

Return on Sales
= Net Profit / Total Sales

Total Equity = Retained Earnings + Owners Equity 

Net Profit =  Sales - C.O.G.S - Other Expenses - Tax Provision 
ROA = [Assets Turnover] * [Return on Sales]

Where:

Assets = Total Sales / Total Assets 

Return on Sales
 = Net Profit [ Total Sales 

Total Assets= Current Assets + Fixed Assets 

Net Profit = Sales- C.O.G.S - Other Expenses - Tax Provision 

The screen presents also a chart that shows the ROE or ROA ratio and its components for a selected period as a diagram.  

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Options

Arrange the screen in different arrangements: display table with chart or just one of them.

ROA/ROE Option

Select if to presents the ROA or the ROE analysis

Export to MS Excel file 

Exports the displayed table to MS Excel
Profit Centers

The Profit Centers analysis presents the profitability of the business units that were defined as markets in the Market Table. 

The revenues for each profit center/market are entered in the Sales Plan screen. The direct cost is calculated according to the cost of the products or services that are sold to this market. The operating expenses and the salaries are calculated according to the allocation of each expense item to a profit center in the Operating Expenses screen.

The screen includes the list of the Profit Centers/Markets on the left side and the revenues and expenses report for the selected profit center during the plan period in the middle of the screen.

To switch between Profit Centers simply click the required profit center on the list.

Toolbar Buttons

The toolbar includes the following buttons: 

OK

Close screen 

Print

Create a report for the current table, showing it on the print preview screen

Display Years

Display only year’s columns or all the periods

Export to MS Excel file 

Exports the displayed table to MS Excel
Operating expenses

The Operating Expenses analysis presents the expenses of each department. The expense items for each department were entered in the Operating Expenses screen. The Fixed expenses, Variable expenses and Salaries are shown on one screen and each group is totaled to a separate line. The variable expenses, that were entered in percentage, and the salaries data, that was entered as annual salary, percentage of social expenses and number of employees for each period, are calculated and shown in amounts.

The screen includes the list of the Departments on the left. To switch between Departments simply click the required Department on the list.
Toolbar Buttons
The toolbar includes the following buttons: 

OK
Close screen (and save all changes if applicable)

Print Table
Create a report for the current table, showing it on the print preview screen

Display Years Only
Display years only or all the periods

Export to MS Excel file
Exports the displayed table to MS Excel

Sales Analysis
The Sales Analysis screen displays the sales that are planned for the plan periods and allows you to analyse, quickly and easily, the mixture of the planned sales grouped by markets or products and what are the expected trends during the plan period.
When the screen is displayed, the first row shows the Total Sales. The next rows show the total sales for each product and how these sales are split by markets. 
Using the Sort button you can select and choose if the analysis will show the total sales for each product detailed by markets, or the total sales for each market detailed by products.
The Sales Analysis is based on the data that was entered in the Sales Plan screen.  It is especially helpful if the data was entered in units with different prices and currencies for each market.   
Toolbar Buttons
The toolbar includes the following buttons: 
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Close screen (and save all changes if applicable)

Print Table
Create a report for the current table, showing it on the print preview screen
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Sort
Sort the displayed data by Products or Markets

 

Actual vs. Plan

The Actual vs. Plan analysis should be loaded after you have used the Actual Data menu, under Plan menu, to enter data of the actual performance of the business during the plan years.

The Actual vs. Plan screens are the same as the Actual Data screens: 
 
· Profit and Loss
· Cash Flow
· Balance
· Plant and Equipment
· Profit Centers
· Revenues/Sales
· Operating Expenses (Budget)
Financial Ratios - The program calculates the main financial ratios based on the data that was entered in the Actual data module. These ratios are displayed and compared to the plan ratios in the Actual vs. Plan module.

Drill Down in Actual Profit & Loss Report
The Profit & Loss report, which is included in the Actual vs. Plan analysis, can now show details for major items such as sales and operating expenses. This makes it easier to understand the variance between Plan and Actual. 

The details for an item can be seen if there is a small plus sign [+] on its left. Clicking on the plus sign will expand the detailed lines. 
( Notes: The detailed lines will be available only if detailed data was entered in the Actual Data screens and it matches the totals in the Profit and Loss report. For example, details of the sales line, by products, will be available only of data was entered in the Actual Sales Plan screen and the total of this data matches the Sales value entered in the Actual Profit and Loss screen.

Each screen presents for each of the plan items and for each selected period, the planned figures compared to the actual figures and the variance between them in amounts and percentages.
The period for the analysis is selected in the period dropdown list on the top of the screen. 

If the first plan year is detailed in months or quarters the analysis will shows for each month or quarter the figures for this period and the accumulated figures since the beginning of the year. In the Balance screen these two values are actually the same but in all other screens it will be shown in different columns.

The Profit Centers screen and the Revenues/Sales screen include the Market list on the left enabling you to select from the list the market for which you want to view the analysis. 

The Operating Expenses screen includes the Department / Expense Group list on the left enabling you to select from the list the department for which you want to view the analysis. The screen includes the three sections: Fixed Expenses, Variable Expenses and Salary & Staff selected with the buttons on the toolbar.
Toolbar Buttons

The toolbar includes the following buttons: 
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Print Table - Create a report for the current table, showing it on the print preview screen
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Forecast

The Forecast module is meant to show the expected performance of the business till the end of the current year, based on the actual data that was entered till now and on the plan data till the end of the year. These two sets of data are combined together in order to calculate the forecast for the annual results and compare them to the original plan. 
The Forecast screens include the following:

· Projected Profit and Loss

· Projected Cash Flow
These screens are included in the Actual vs. Plan menu, at the end.

In order to get the proper forecast it is required to enter data in the Actual Profit and Loss and Actual Cash Flow screens. The software will take the data entered, add to it the data from the plan for the following months and calculate the year total.
Toolbar Buttons
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Print Table - Create a report for the current table, showing it on the print preview screen
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Tools Menu

After you have entered the data for your plan and analyzed the results of the plan, the Tools menu enables you to generate reports and graphs that will present the plan results. If you need to produce a full business plan document the business plan guide and template will assist you in developing the required document.

The Tools menu includes:

Reports

Generate reports

Graphs

Generate graphs

Sample Plans

Load samples

Business Plan Guide

An on-line Guide on how to prepare a business plan

Business Plan Template

A pre-prepared business plan template that can be loaded to your word processor.

Financial Ratio Generator

The Financial Ratio Generator has been designed to enable you to define your own financial ratios.
Import Actual Data

This module is used to import external data that is generated by another application.
Comparison Analysis (Pro version only)
The comparison analysis enables you to compare the results of one plan to another plan.

Reports

All the data, analysis and graph screens of the Business Planner have a Print button in their toolbar, which generates a report of the screen contents. The report is displayed on a preview screen that enables you to customize, print and export the report. If you want to create various reports from different screens in one run you can do it in the Report table as explained below.

Report Table
The Report Table allows you to create, quickly and easily, reports that present the data and analysis of the business plan.

The reports are generated by checking the required reports from the report list and clicking the Display button.

Reports Preferences
The Report Table includes a section of preferences that assist in the creation of the reports according to the requirements. By using the preferences you can create reports for only part of the plan years, for years only, with or without previous years, etc.  The number of columns in each report page can also be set, allowing for better quality of annual reports.

The Preferences include the following parameter

Start Year
The first year that will appear in the reports.

To Year

The last year that will appear in the report. This year should be equal or greater than the start year.

Print years only

If this option is marked, the reports will include only years. Data entered or analyzed by months or quarters will not be included.

Show previous periods

If the plan includes data from previous periods, as defined in Periods tab in General Data screen, this data can be included in the reports by marking this option. This is applicable only to reports that use previous periods' data, such as the Profit and Loss, Balance and Financial Ratios.

Max. Number of columns per page

This parameter enables to limit the number of columns that will be included in a report page.

New page for detailed year

This parameter can be used to create the report so that each year that is detailed by months or quarters will start from a new page.

Show percentage columns

This option enables to include percentage columns in the Profit and loss, the Operating Cash flow and the Balance.

Buttons
Print Setup
Display the print setup dialog enabling you to select printer, change page orientation, etc.

Mark all
Choose all reports from the list

Clear All
Clear the selection of reports from the list

Display
Generate the chosen reports to the preview screen
Exit
Close screen - Close the Report Table screen 

Print Preview

The Print Preview screen enables you to view on-screen how the report will be printed onto paper. The buttons displayed at the top of the preview screen are used for the following functions:

Print
Causes the standard windows print dialog box to be displayed. Using the various parameters available to you here, you can choose to print multiple copies of the report, send the report to a printer other than the default printer and set other properties depending on your specific printer driver.

Customize
Displays the Report Customization screen. Here you can alter almost all of the parameters that affect the presentation of your report. The Report Customization screen is discussed in more details below.

Export
The Business Planner allows you to export the report to MS Excel format, (.xls), or to an Internet format (.html). Click the Export button to load the Export screen. This screen is explained in more details in the second section below.

Zoom
Using the Zoom dropdown list, you can change the size of the previewed report to see it bigger or smaller. You can view all the pages of the document on the screen by choosing the Thumb Nail option from the Zoom list.

Report Customization 

The Report Customization screen enables you to customize the report by setting the parameters that determine the report’s appearance. The screen is organized with Tabs, each Tab dealing with a different set of parameters. 

If the report includes a table, you can see on the right, a Sample Grid that shows the table. When you change the report parameters and click the <Apply to Sample Grid> button, the Sample Grid will show you the effects of the changes. If the report includes a graph, the Sample Grid will not be seen.

Once you have customized a report and you would like to save the current parameters in order to use them in the future for more reports you can use the Report Formatting Styles tab to save and load report styles.

Report Customization Buttons
OK 
The OK button updates the report on the Print Preview screen with the new display parameters that were entered in the Report Customization screen.

Cancel 
The Cancel button returns to the Print Preview screen without any changes.

Apply to Sample Grid 
This button will update the Sample Grid to the right of the Tabs with the new report style.

Hide Sample Grid 
This button will hide the Sample Grid and center the Report Customization Screen.

Grid Tab

The Grid Tab includes parameters that determine the appearance of the table in the report. 

( Note: This tab appears if the report includes a table and not a graph.
General Grid Parameters
Row Color 
This option lets you select the background color for the Report Table. Click the button <…> to the right of the square to display the standard Windows Color dialog box from which you can select the required color. 

( Note: The available colors will be shown according to the graphics card on your computer.
Alternate Row Color 
This option is used similarly to Row Color. If the color chosen is different from the Row Color, then the report will be generated with this color as a background color for each second row, while the first row will have the row color as background color.

Display Grid Lines 
Determines if the grid lines are displayed or hidden on the report.

Grid Font Parameters 
The font settings that are defined here are used for the regular text that appear in the table in report. Click the button <…> to the right of the text box to display the standard Windows font dialog screen. In this dialog you can choose an appropriate font, its fore color, size, style, etc. 

Page Orientation
Choose the page orientation (portrait or landscape) of the report.
Page Margin Parameters
These parameters determine if the page margins are visible in the preview screen and where they are positioned.

Display margins in Preview
Determines if the Page Margins are visible on the Preview screen (not in the actual printed document),

Top Margin, Bottom margin, Left margin and Right margin
These values determine where the margins of the report are positioned on the page. The units for the margins are centimeters.

Print table in black and White 
You may select this option if the reports that you print in colors are not clear enough. The tables in the reports will be printed in black color on white background. In this case the table will be printed better if you check the 'Display Grid Lines' option. 

Header Tab

The Header Tab includes parameters that determine the headers and the sub headers that will appear in the report.

Report Title
Report Header 
Allow you to change the default main header of this report.

Font Parameters
Allow you to determine the parameters of the font used to display the report header.

Sub Header Texts
Here you can define sub headers lines that will appear above and below the report’s main header.

Display Company Name 
Determines whether the company name, entered in the General Data screen, is displayed above the report header.

Display Plan Name 
Determines whether the plan name, entered in the General Data screen, is displayed above the report header.

Display Prepared By 
Determines whether the name of the person who prepared this plan, entered in the General Data screen, is displayed above the report header.

First Sub Header
Allow you to enter any text to be displayed on the first line after the main report header.

Second Sub Header
Allow you to enter any text to be displayed after the first sub header.

Third Sub Header
Allow you to enter any text to be displayed after the second sub header.

Font Parameters
Allow you to determine the font parameters of the sub headers.

Insert empty line before and after title
Allow you to determine if the report will have an empty line before and after the main title.

Footer Tab

The Footer Tab includes the parameters that determine the contents and look of the footer line that is displayed at the foot of each page of the report.

Footer Information
Font Parameters 
Allow you to determine the font parameters of all the text displayed in the footer line

Display Date 
If this option is marked the date will appear in the page footer

Display Time 
If this option is marked the time will appear in the page footer

Display Page Number
If this option is marked the page number will appear in the page footer

Display Footer text at right 
This field allows you to enter any text that will fit into the area at the right hand side of the footer line.

Picture/Logo Tab

The Picture/Logo tab allows you to insert a picture of the company logo or any acceptable graphics file on each page of the report

Picture/Logo Parameters
Logo File Name 
Use the button at the right of the file name box to locate the graphic file that you want to display on each page of the report. The picture file will be displayed at the position determined by the two parameters below and its size will not be altered by the preview. This means that you must adjust the size of the picture externally before generating the preview.
Logo Pos. Top 
The top position of the picture file on the report.

Logo Pos. left
The left position of the picture file on the report.

Report Formatting Styles Tab

This tab will allow you to use and create predefined styles for the reports. The styles include all the parameters that are entered in the other tabs of the Report Customization window. The header on the top of the Report customization screen always shows the active style. 

Available Styles
The Available Styles list contains various predefined styles. When you install the software, a few styles are supplied with the software. You can easily add specific styles that match your requirement by changing the parameters of the report customization and then using the Save button on the right of the list.

You can view a style by double clicking on it in the list or by selecting it and clicking the Load button. The Sample Grid displayed at the right of the screen will adjust itself to the new style immediately.

Style Buttons
Load Button 
Use this button to load the selected style

Save Button 
Use this button to save the current style, or by changing the name to create another style.

Rename Button
Use this button to rename the selected style

Delete Button
Use this button to delete the selected style

Export Reports

In the Print Preview screen you can export the report to a file by clicking the Export button. The Export dialog will appear and you will be able to export the report doing the following steps:
Step 1 - Choose the export file format
The Business Planner allows you to export the report to MS Excel format, (.xls), or to an Internet format (.html)

Step 2 - Choose the name of file to which the export will be done. This field shows the last file name to which you did export in the past. Use the button with three dots to open the File Dialog where you will be able to choose the folder where the export file will be created and to give a name to the file.

Step 3 - Click OK
When you click the <OK> button the export file will be generated. You are given the possibility of viewing the exported file within its parent application (Excel, Internet Explorer, etc.) by checking the 'Open Exported file After Generation’ option.

Graphs

A graph is as an important tool to present business data and trends. In most cases, it is much easier and quicker to understand the financial plan from a graph then from a table of numbers. The graphs are generated in the graph table as explained below and can be easily customized according to your needs.

Graph Table

The Graph Table allows you to create graphic presentation of the data and the results of the plan quickly and easily.

The graphs are generated by checking the required graphs from the pre-prepared graph list and clicking the Display button. Each graph that was checked will be generated and displayed in a separate window. It can then be customized with many options. 

The graph list is arranged in a tree structure where the graphs are grouped by the main financial reports: Profit and Loss, Balance, Cash Flow and Financial Ratios. 

On the right side of the screen there is a period list where you have to select the period for which you want to present the graphs. Selecting All Years will generate graphs that show the data of all the plan years. If the period definition of one or more of the plan years (entered in the General Data screen) includes months or quarters, this year will also appear in the period list. If you select this year the graphs that will be created will show the data for this year in months or quarters.

Buttons
Mark all
Select all graphs from the list

Clear All
Clear the selection of graphs from the list

Display
Generate the selected graphs

Exit
Close the Graphs screen 

User Defined Graphs
This feature is explained in detail below

The Graph Window

Graphs that were generated by the Graph Table are each created in a separate window. The graph can be customized, printed and exported to a file by using the buttons on the toolbar. Double clicking the graph or as clicking the Graph Setup button on the toolbar loads the Graph Setup screen.

When you move the mouse across the graph sides you may see that the mouse icon changes in a few points. When it happens you may click the left button of the mouse and resize the graph box.

Toolbar Buttons

OK

Close the graph window

Print

Create a report for the graph, showing it on the print preview screen

Graph Setup

Load the Graph Setup screen. 

Export

Export the graph to a bitmap file

Graph Setup

The Graph Setup screen enables you to customize displayed graphs or to pre-set the individual parameters for each graph in the Graph Screen.

The Graph Setup screen is arranged with Tabs to group the various parameters.

General Tab

The General Tab includes parameters that determine the overall appearance of the graph on the screen.

Colors

Palette 

Use this dropdown list to choose the palette that you want to use to display different series (collection of values) on the graph.
Effects

3D

Displays the chart in 3D mode

Show Color Legend

Displays a legend of the graph series showing the connection between a color used to display a series and the series name

Stacked

Displays bars on the chart in stacked, stacked 100% or normal mode.

Axis Style

Applies a specific painting style to the chart’s axis. 

Grid Lines

Displays horizontal or vertical gridlines or both on the chart.

Appearance

Scheme

Define the appearance of the elements in the chart (bars, pie). The default is solid colors but you can also choose Black & White or colored patterns.

Background

Choose the color you want as a background in the area surrounding the chart. 

Chart Box

Choose the color you want as a background in the chart area.

Titles

Graph Title

Enter the graph title. Use the button on the right to set the title fonts.

X-axis

Enter the X-axis title. Use the button on the right to set the title fonts.

( Note: in a Pie graph, the labels are presented with the font setting that you selected here.

Y-axis

Enter the Y-axis title. Use the button on the right to set the title fonts.

Style Tab

The Style Tab allows you determine the style of the graph and specific parameters for the series displayed in the graph



Series

If the graph includes more than one series then use this dropdown list to select the series. Then, for each series you can enter the name of this series that will appear in the legend.  

Border

Use these parameters to customize the appearance of the border surrounding the graph and the series shapes

None/Custom

Select None so that no border is displayed or Custom to display the border. 

Color

Select a color for the border.

Style

Use the drop down list to select a line style for the border.

Weight

Use the drop down list to select a line weight for the border.

Styles

Use these parameters to customize the appearance of the body of the graph.

Gallery

Use the drop down picture list to choose a graph style
Gap Width

Enter a gap width to determine the space between one element of the graph to the next.

Show Point Labels

Choose if the graph will display point labels at the end of each graph element.

Cluster (Z-axis) 

Lets you display series in different rows along the z-axis. 

3D Tab

The 3D Tab allows you determine the appearance of the graph as a 3D chart. The 3D parameter should be checked in the General Tab of this screen in order to apply the 3D parameters.

Rotated View

Check this option if you want to alter the angle that you view the graph from.

X-axis

This value sets the angle of the X-axis in a rotated view. It can be entered directly or by using the slider to the right of the small graph displayed on this tab

Y-axis

This value set the angle of the Y-axis in a rotated view. It can be entered directly or by using the slider at the bottom of the small graph displayed on this tab

Depth

Use this slider to change the depth of the displayed elements in the 3D graph. The results are clearly visible on the small graph displayed on this tab.

Perspective

Use this slider to change the perspective of the displayed 3D graph. The results are clearly visible on the small graph displayed on this tab.
Graph Setup Buttons

The function buttons at the bottom of the Graph Setup screen are as follows:

OK

This button will save the parameters of the current graph to use whenever this graph is displayed and close the Graph Setup screen. If the graph is displayed on-screen, it will be updated according to the changes in the parameters.

Cancel

This button will simply close the Graph Setup screen without updating anything.

Apply

The Apply button operates like the OK button without closing the Graph Setup screen. It saves all the changes that were done so far for future display of the graph and it updates the graph (if the graph is displayed on-screen).

( Note: The Cancel button will discard only changes that were made after clicking the Apply button. 
User defined graphs

This screen enables you to define what component row items are to be displayed in your User Defined Graph

Use the Graph Title box to give a new title or edit an existing title.

Use the tree structure in the Items list to select the item that you want to be used in your User Defined Graph.

A double-click on the selected item or use the button to transfer the selected Item to the Selected Items list.

Buttons
OK
Closes this screen and saves the data

Cancel
Closes this screen and discards any changed data

Help
Displays this Help Item

Graph Properties
Enables you to define the Graph Display Properties used when the graph is generated

Graph Preview
Enables you to see a preview of the graph

Sample Plans

The Sample Plans screen allows you to load sample plans that were pre-prepared in order to help you to start working with the software more easily. 

The screen includes a quick explanation on how to use the software and a list of sample plans by industry type, e.g. Manufacturer, Reseller, etc.

Select the sample that is closest to the industry that your business belongs to and click the Load Sample button or Double-Click on the chosen sample plan.

The file dialog will be displayed and you will be asked to give a name for the plan file. After you enter a name the plan file will be created and you will be able to start working with the sample file.

The sample includes items and definitions that are commonly used by businesses similar to your business. You will have to enter the name of your specific products, markets and department and you may delete, add or change all the items in the tables, Operating Expenses screen and other screens.

Business Planning Guide

The Business Planning Guide is a computerized book that includes thorough explanations on how to prepare a business plan document. It guides you step by step in creating a professional plan. 

The Business Planning Guide is built and used as a regular Windows help file. The first screen includes the Contents with a list of a typical business plan topics. Clicking each of the topics will load the explanation for this topic.

Business Plan Template

The Business Plan Template is a word processor document that includes the headings of a business plan with explanation for each section. You can use it along with the Business Planning Guide to produce your business plan document. 

When you click this option in the Tools menu the software will look for the word processor that is installed on your computer and if it is found, it will be loaded with the business plan template ready for editing. The template can be edited by any word processor that can open Rich Text Format (RTF) documents. Almost any word processor in Windows can do that. 

( Note: Delete the lines of instruction in the template file, or mark them as comments, before printing.

Financial Ratio Generator

The Financial Ratio Generator has been designed to enable you to define your own financial ratios based on values available in the existing analysis reports. The user defined ratios will be calculated together with the built-in financial ratios and presented in the analysis and the reports as part of the Financial Ratios screen (at the bottom).
The Generator includes two screens:

Financial Ratio Generator
This screen includes the list of the user defined ratios. It enables you to add a new ratio, delete an existing ratio or edit an existing ratio. When you select to add or edit an existing ratio, the second screen "User Defined Ratio"  will be displayed and will allow you to edit the formula of the ratio. When you close the editing screen you return to the list and you can continue to edit other ratios or close the screen.

User Defined Ratio
This screen allows you to build or edit the ratio formula. The Item list on the left contains all the row items available in the financial report screens. You can expand or close the tree items to display the various components. 

When an item is selected and the ">" button clicked, the item is transferred to the list on the right hand side of the screen. Double clicking the item will have the same effect.

The buttons above the component list will allow you to insert mathematical operators (+-*/^) into the ratio and the number buttons allow you to insert numbers.

When you want to remove an item from the formula, click on it and the click on the "<" button. If you want to remove all the items of the formula Click on the "<<" button.

The assembled ratio will be shown in the yellow display box at the bottom of the screen

The "Verify" button will allow you the check the expression that you have constructed to see if it is mathematically viable.

Using the "OK" button will process the formula expression through the Verifier anyway and the expression will be saved.

Import Actual
This module is used to import external data that is generated by another application (e.g. Accounting software) directly into the Actual Profit and Loss, Actual Balance and Actual Operating Expenses screens of the Business Planner.  
( Note: Before you import any external data, we suggest that you backup your present Plan or use the Save As function so that any changes brought about by this import module can be discarded and the original plan restored.

The import is achieved by preparing a profile for the import. This profile contains all the necessary specifications to process the import from a source file/document at any time without redefining the import specifications.
The Import module is used by the following steps:
Step 1. Add a new import profile or edit an existing profile
From the Tools menu item, select "Import Actua Data". The Import Profiles screen will be displayed. This screen shows a list of import profiles that were defined in the past. It allows you to add a new profile or edit an existing one. Click the Add button or select an existing profile and click the Edit button and the Import Data Wizard will appear.
Step 2. Choose the source file and adjust import parameters
The first screen of the Import Data Wizard allows you to enter the profile name and then use the button at the right hand side of the Source File field to choose the file that you want to import. It can be an MS Excel file, (.xls), or a text file, (.txt). 
If an MS Excel file is chosen, a drop-down list with the list of worksheets that are included in the Excel file, will be displayed below the file name. Use the Worksheet list to select the required worksheet, and the data of the selected worksheet will be displayed in the preview table at the bottom of the screen.
If a Text file is chosen, then the file content is displayed in the Preview table with the Tab Delimited as the default delimiter. If the data does not display as you would expect it to be, then uncheck the Tab Delimited option and use the Delimiter Text field to enter what the delimiter character. If you are not sure what this means, enter a comma, and click the Profile name text box. The Preview table will show the data delimited by the new delimiter. If the data is shown as you would expect it to be, column by column, then you have found the correct delimiter. Other possible delimiters are <Space>, #, (;), (:), etc. However, the usual ones are commas or spaces.
Now you can choose if the Import will Replace the relevant data in the plan's actual section, or if the imported data will be Added to existing values in the plan.
Click the "Next" button to move to the next Wizard screen.
Step 3. Specify the type of the columns in the Import file
The second screen of the Import Data Wizard allows you to define the type of data that the columns in the import file contain. 
Use the drop-down list which appears on the top of each column when the first cell is clicked. The list includes 'Row Code' item and then the periods of the existing plan. Select the column that hold the codes and the descriptions of the data rows and choose the Row Code type for it. Then select for each column that includes values what is the period that these values belongs to.
Click the "Next" button to move to the next screen before the import can be initiated.
Step 4. Link rows from the source file to rows in the Actual Data screens
The third screen of the Import Data Wizard is used to define the link of any row in the imported data to rows in the Profit and Loss, Balance and Operating Expenses screens. 

The rows of the imported data are displayed on the left list. Rows that have values are colored with green. Rows that are already linked to rows in the plan are colored in blue and are presented in bold letters.

The available target rows are presented on the right, grouped by their parent items.

Choose a row from the imported data and then select the target row and click on the second column. A drop-down list will be displayed where you can choose either to add the imported value to the target row (+) or subtract it from the target row (-).

If you click on the "Finish" button all the import profile definitions will be saved to the profile data base and will be available to you for future use.

If you click "Import" all the import profile definitions will also be saved to the profile data base. The software will then run the Import Profile and import the data to the actual data section of the current plan.

( Notes:
1. It is highly recommended to check the Actual screen, which is the target for the import, before the import is run, and make sure that it does not include irrelevant data that was entered manually or by a previous import.
2. After the import is run, it is recommended to check the imported data in the Actual screen that was the target for the import. 
 

Future Use
In the future, when you want to import a similar file but with updated data, all that is necessary is to choose the Import profile from the profile list, click the "Edit" button and go through the subsequent three screens. 
( Note: You will need to change the period type in the second wizard screen if the updated data belongs to another period. 

Then use the "Import" button on the last screen to run the profile and import the data.  The Import module checks your data at each step to see that there is compatibility to the current plan.

 

Options Menu

These items enable you to change system wide parameters and update and maintain the computer health of the Business Planner environment

The Options menu includes:

Preferences
Define parameters that control important functions of the software.

System Options
Select method for the financial reports' presentation, and select language (if applicable).
Internet Update
Search for software update in the Internet and install the update if applicable.

Compact Database Files
Perform maintenance operation on the databases and plan files 
Import Sales Planner data
Import products and sales data from the Sales Planner software
Preferences
The Preferences window enables you to define parameters that control important functions of the Business Planner. The screen is arranged in a card file (tabs) structure, each with specific information and functions. Use the mouse cursor to click on a required tab and the display will change to show you the relevant information.

Buttons
The buttons at the bottom of the screen are:

OK
Close screen and save all changes

Cancel
Close screen without saving the changes

Defaults
Replaces existing values with system default values to the section/tab that is currently presented

Password 
The software enables to define a password that will be asked any time the software is loaded and will prevent unwanted visitors to load the software and view your plans while you are not at your desk.

The password is defined and activated by clicking the Password button at the bottom of the Preferences screen. The Password screen will be opened.

In the screen you can mark the option "Use password to enter the software". Marking this option will display a password screen each time the software is loading and will allow to use the software only if the correct password is entered.

If you want to use password, enter the current password (if a password was already defined) and then the new password, twice. Click the OK button.. and remember the password.

( Note: Password is case sensitive. If lost or forgotten the use of the software will not be possible. It is recommended to use the password function only if you really need the protection.

Grid Parameters Tab

Most of the data and analysis screens of the Business Planner show data in a grid (spreadsheet like) structure. You can change the following parameters in order to customize the display of the grid according to your requirements:

Cell and Row Parameters
Grid Font
Select the font name, style (regular, bold, italic, etc.), font size and font color that will be used to display regular text and numbers on the grid.

Row Background Color
Select the background color of the regular text and numbers on the grid. Text and numbers, which are not regular, such as a column that displays the total of other columns, will usually be displayed in other colors not customizable by the user. 

Alternate Row Background Color
If this color is different than the Row Background Color, the grid will show every even row with this alternate background color while every odd row will be shown with the regular row background color. 

Selected Cell/s Background Color
Here you can set the color of a block of cells on the grid which has been selected with the mouse or keyboard.

Color of unused area of grid
This option lets you select the color of the area that appears below and to the right of the grid, if the grid does not cover the whole area in its window.

Show zero values for data entry
This option allows you to customize the content displayed in cells in data entry screens when these cells contain zero or were not filled-in with any data. The options are to display an empty cell or to display zero.

Color negative values with red 
Here you can choose if cells in data entry and analysis screens that are negative values, will be displayed in a red color (or Yellow if the background color is dark gray.

Show row numbers on data screens
Here you can choose if the column with the row numbers will appear as the first left hand column in tables that are included in data entry screens. This column can assist the user to locate items in data entry, especially when you enter a large number of items in a table and you scroll up or down to find an item. 

Show row numbers on analysis screens
This option is identical to the above option but affects only analysis screens. 

Period column parameters
Column width - plan
Here you can change the width of the columns that contains periodical data in the data entry screens. 

Column width - analysis
Here you can change the width of the columns that contains periodical data in the analysis screens. 

( Note: Most of the data entry screens and analysis screens include data by period and the number of columns differs according to the period definition you have entered in the General Data screen. You may enter a smaller width if you want to view more columns on the screen providing the data you enter does not include numbers that are too big to fit in the column.

Table/Grid Lines
Display Grid Lines
You can decide to show or hide grid lines on the grid by checking or unchecking this check box.

Grid Line Width (1, 2, 3 or 4)
Here you can set the width of the grid line by selecting 1 to 4. The bigger the number, the thicker is the line. 

Grid Line Color 
This feature lets you select the color for the displayed grid line.

Number formats
Decimal places - plan
You can enter here the number of decimal digits for numbers displayed in the Data Entry screens.

Decimal places - analysis
You can enter here the number of decimal digits for numbers displayed in the Analysis screens.

Decimal places - percentages
You can enter here the number of decimal digits for numbers displayed as percentages

Use thousands separator - plan
You can choose here if the numbers displayed in the Data Entry screens will include the thousands separator. 

Use Thousands Separator - Analysis
This option is identical to the above option but affects only Analysis screens. 

( Note: The Thousands Separator character and the Decimal Point character are taken from the Windows Regional Settings.
Plan Navigator Parameters Tab

Tree Style
The following parameters determine the look and style of the Plan navigator that shows the main plan and analysis items in a tree like structure.

Font
Select the font name, size, style and color for the text that appear on the branches of the Plan Navigator Tree. 

Background color
Select the color for the background of the tree.

Navigator Operation
Item activated with one click
If this option is marked, when an item in the Navigator is clicked, the function that this item activate, will be processed. Otherwise, a double-click is needed. 

Operation Options
Show Plan Navigator at start up
If this option is marked, the Plan Navigator will be displayed automatically every time the Business Planner is started.

General Parameters Tab

Data Options
Show Year Total Columns in data screens
This check box allows you to display or hide the year total columns in the Sales Plan, Operating Expenses and Plant and equipment screens. The cell values in these columns are automatically updated when one of the previous cells participating in that year is altered

Background color of Year Total columns
This feature allows you to choose the background color of the Year Total column

Related Screens
Close data screen when a linked item is loaded
This check box allows you to decide if the software will close automatically a displayed data screen when another data screen,  that includes data which is being used by the first screen, is being loaded. For instance, if the Sales Plan is displayed and the Products and Cost screen is loaded, adding a product would affect the Sales Plan. If this checkbox is checked, The Sales Plan screen will be closed before the Products and Cost screen can be displayed.

Sub Total row colors
Choose the background and text color of sub total rows. These parameters may be important on some printers as certain color combinations are not clearly distinguished.

Total row colors
Choose the background and text color of total rows. These parameters may be important on some printers as certain color combinations are not clearly distinguished.

Excel Connection Tab (Pro version only)  
The link to MS-Excel is conducted according to parameters that are set in the "Excel Connection" tab in the Preferences screen.

The parameters include:

Activate Connect-To-Excel functionality 

This option should be marked in order to apply the link to MS-Excel. When it is unmarked you will not be able to define new links to MS-Excel and any links that are already defined will not work.

Clear the cell value when the MS Excel Connection is deleted

When the link is created the value from the Excel cell will be imported into the linked cell in the specific data table. If the link of a cell to MS-Excel worksheet is deleted the data that was imported can stay or cleared according this parameter. If it is unmarked (recommended) the data will stay and you can then edit it manually if necessary.

Enable editing of cells that are connected to an MS-Excel worksheet

This parameter defines if cells that are linked to Excel worksheet can be edited or not. If editing is allowed, changing the content of a cell will automatically delete its connection to the Excel worksheet. If editing is not allowed but required, the link to excel should first be deleted and then the cell can be edited.

Force a data update from connected MS-Excel worksheets before calculation

This parameter defines if the software will update all the data in all the screens that are connected to Excel worksheets, before calculating the plan results in order to show the analysis and the reports. It is recommended that the parameter will be marked; otherwise the analysis results may not reflect the latest changes in the connected Excel sheets. 

Background Color of marked Excel connected cell

When viewing a data table in which cells are connected to Excel sheets it is possible to ask the software to color them in order to locate easily which cells are already connected. Here you can select what will be the background color of the linked cells.

System Tab

Default Path to Save Plan Files

This field allows you to define the default path where plan files will be saved to and loaded from. If this field is empty, the default is the subfolder "Plans" under the software folder. To select another folder click on the button with the 3 dots on the right side of the field. The folder dialog will open and you will be able to select a folder for the plan files.

The default folder is used to save new plan files. If you open a plan file that is located in another folder, when you save it, it will be saved to its origin folder.

Internet Update
Check for Update on the Internet automatically 
This option enables you to decide if you want to run the Internet Update module automatically. If this option is checked, the Internet Update will run when you start the software, every 30 days (or another number of days as set in the next item). If you uncheck this option, you can still activate the Internet Update manually, every time you want to, by running it from the File menu.

Number of days between automatic update check
Here you can set the number of days that will pass between each automatic activation of the Internet Update module.

Functions Tab

Analysis Options
Show zero values for analysis display
This option allows you to customize the content displayed in cells in analysis screens, when these cells contain zero or were not filled-in with any data. The options are to display an empty cell or to display zero.

Show previous period columns
This check box allows you to display columns for defined previous periods in the Profit and Loss, Balance and Financial Parameters screens

Profit Center Options
Use Profit Centers
This check box allows you to decide if to use Profit Centers analysis. If you select not to use it, the Operating Expenses screen will not include a column that enables you to link expenses item to a profit center. In addition the Profit Centers screens will not appear in the Actual Data menu, Analysis menu and Analysis vs. Plan menu.

Tax Advances as % of.
Choose if tax advances, entered in the Financial Parameters window under Plan menu, will be calculated as a percentage of the sales or the net profit.

Depreciation Starts at…
Here you can choose the depreciation period, namely, if an investment is acquired (as entered in the Plant and Equipment window under Plan menu), when will it start to depreciate - in the investment period or the following period.

Display Profit and Loss Breakdown
This checkbox will determine if the breakdown of Expenses and Revenues is implemented in the Profit and Loss analysis screen. You may want to disable the breakdown if you want to copy data from the Profit and Loss screen and paste it to Excel. In this case, if the Breakdown is not disabled, the pasted data will include the breakdown data even if the breakdown lines were collapsed.

System Options

In the System Options screen, you can change the style of the Profit & Loss report created by the Business Planner. You can select the Direct Cost method or the Total Cost method, and the P&L report will be presented according to your choice.

These methods are different from each other mainly in the way the costs are presented.

In the Direct Cost method, the cost of the products or services that is included in the Profit and Loss report reflects only the cost of the products that were sold during the period of the report.

In the Total Cost method, the cost of the products or services includes all the expenses spent for production during the period of the report, including cost of materials and labor for products that are still in inventory and were not sold. In this method the Income (production) of the company includes both sales and change in inventory, while in the Direct Cost method, the income includes only sales.

If your version supports the Multi-Lingual facility, then you can choose here the language interface that you want to work with. Changing a language will change the software interface and the text of the screens, reports and graphs. Everything is changed except terms and items that you yourself have entered, such as the name of the business, descriptions of expense items, etc. These terms you will have to translate yourself if necessary.

Internet Update

The Internet Update function searches the Internet for an update for the software. If an update is available, it will be downloaded and run.

The function will be activated automatically on the first time that the software is run after installation. Then it will be reactivated automatically on a periodic base, every 30 days, when you start the software. 

You may activate the Internet Update module manually whenever you want, by selecting it from the File menu. 

The Internet Update options can be set in the Preferences screen (under the General Parameters tab). These options enable you to decide if you want the Internet Update to run automatically, which is the default, or manually. If you selected to run it automatically, then you can set the number of days that will pass between each automatic activation. 

The Internet Update has the following steps:

Step 1 - an explanation screen is displayed and enables you to continue with the update or to terminate it. If you select to terminate the update now, it will run again after 30 days (or another number of days if you changed it in the Preferences screen). During this period you can activate the Internet Update manually, every time you want to, by running it from the File menu.
Step 2 - a progress screen is displayed and the process of downloading the update program starts. First it checks if there is an update program for your version of the software. If there is it will download this file and when the download is completed, it will display a message screen informing you that the update file has been downloaded successfully and will ask you to press the OK button if you want to proceed to run it. At this point you may stop the update process by pressing the Cancel button, but it is recommended, of course, that you press the OK button and execute the update.
Step 3 - The application will then shut itself down and the update program will run. It will display screens that will show you the process and, when it has finished, will restart the application.

( Note:  Before running the Internet Update, check that your computer is connected to the Internet and that the connection is established. If you are working on a plan, save it before running the Internet Update.

Compact Database Files

The Compact Data Files function is important to keep the databases that are used by the Business Planner in good shape and minimum size. While the Business Planner is being used, a large amount of backup and temporary data is created and deleted data is not physically deleted from the database file. The compact utility removes all the redundant data and keeps only the current data in the database file. In many cases the size of the compacted database file will be reduced by 70-80%. 
The Compact Data Files function runs automatically every 100 times that you started the Business Planner. However, we recommended running it manually before saving plans to files and before making backups of the database files.

Import Sales Planner Data
If you work with the Planium Sales Planner, you may use this function to import data from a plan that you have prepared with the Sales Planner. The data that can be imported includes the Product Table, the Market Table and the Sales Plan. 

The import is done in the following steps:

Step 1. - Select the file that you want to import from a list of files displayed by the file dialog. You may change the path and directory to find the required file that you want to import. Files that were made with the Sales Planner have the extension ".spf".

Step 2. - Select how you want the price of a product or a service to be imported. The reason for this selection is that the data in the Sales Planner is organized in a different way to that in the Business Planner. While in the Sales Planner, you can enter different prices per unit for each month, in the Business Planner you can enter one price per unit, which will be used for all the months. You may select between the following two options: 

1. Calculate a weighted average price from the Sales Planner - the sum of the quantities multiplied by price for each month will be calculated and this total for all the months will be divided by the total quantity to give a weighted average unit price.

2. Import the price of the first month. - The unit price of the first month will be used in the Business Planner.

Step 3. - Click the OK button. The import will be done in a few seconds.

( Note: The Import from the Sales Planner overwrites the existing plan period data, product table data, market table data and sales plan data with the imported data. Before running the Import, It is recommended to make a backup of the existing plan by using the Save As function under File menu. If you want to import the data to a new plan, use the New function under File menu to generate a new plan before running the Import. You can then safely import existing data from the Sales Planner into the new plan.
Windows Menu

The Windows menu is used to arrange the windows that are displayed on the screen.

Cascade

Arrange windows so that they overlap in a cascade arrangement

Tile

Arrange all windows side by side in a tile arrangement

Arrange Icons

Arrange icons of minimized windows at the bottom of the screen

Close All

Closes all windows except the main application window and the Plan Navigator (if displayed).

A list of all the windows, which are currently displayed, is found in the Windows menu. In a case where a large number of screens are being displayed and you do not know how to find a specific one, you can use this menu item which will display all then loaded screens. Moving the selected line to the required screen and clicking it will bring it to the foreground as the active screen. 

Help Menu

The Help menu options provide help on using the Business Planner.

The Business Planner help system is operated like any other standard Windows help file. For more in-depth information, see How to Use Help in the Windows User's Guide.

The Online help can be activated at any time when using the Business Planner, by pressing the F1 function key or the Help button on the toolbar, (yellow question mark button). The help topic displayed will be dependent upon which window is active at the time. 

The Help menu items are:

Contents

Show the first screen of the Help file with a list of its contents

Index

Activate the help with the Index function on. In this case, The help screen that is displayed includes also a Find tab where you can type a word and find help concerning this word.

About

Display a proprietary window about the software version and authors

Keyboard Shortcuts

Keyboard shortcuts to activate menus are presented in the following table:

	File / Calculator
	F5

	Edit / Cut
	Ctrl + X

	Edit / Copy
	Ctrl + C

	Edit / Paste
	Ctrl + V

	Window / Cascade
	Shift + F5

	Window / Tile
	Shift + F4

	Help
	F1


( Note: To select menu options using the keyboard, press Alt and the underlined letter of the menu option. For example, to select the File menu, press Alt+F.

Pressing any alphanumeric key in a browse / table data entry window invokes Edit mode automatically, overwriting the previous value of the cell.

Marking a range of cells is possible using the keyboard by holding down the shift key and moving in the required direction with the arrow keys.

Special keyboard keys

	Enter
	Activates default OK button (saving data)

	Escape
	Activates default Cancel button (without saving data)

	Tab
	Moves between fields in multiple fields windows

	Space
	Activates (presses) the button in focus
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The Business Plan's Contents

The following tables present examples of business plan's table of contents, for manufacturing business and for trade or service business.

Manufacturing Business

Table of Contents
Page
Executive Summary

The Company - History and Present

The Products and Services

The Market Analysis

The Marketing Strategy and Plan

The R&D Plan

Management and Organization

The Operational Plan

Facilities and Equipment

The Financial Plan

Appendixes
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The Technology

The Market
Trade or Service Business

Table of Contents
Page
Executive Summary

The Company - History and Present
The Products and Services
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The Operational Plan
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Appendixes
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The Market

Executive Summary

The executive summary provides a snapshot of the entire business plan, including the following sections:
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Business Description
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Products and Services 
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Market & Business Opportunity
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Financial Highlights

Business description

Briefly describe the Business Profile, including the following details:
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Main activities
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Date of establishment
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The owners
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The market positioning
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The objectives

If your plan is for a start up business, focus on the new business description.

Products and services

Describe your main products, product lines, or services. Emphasize the advantages of your product, and what makes them attractive to customers.

Market & business opportunities

Describe your target markets, market size, and market share. Explain the business opportunity your market offers.

Financial highlights

Describe the projected financial highlights for the forecasting period. The financial highlights include projected sales, profit, cash flow, main financial indicators, and required investment, providing a clear picture of the business potential and opportunity.

Financial highlights Example

	Period
	Revenue

(K-$)
	Op. Profit

(K-$)
	Op. Profit

(%)
	EBITDA

(K-$)
	Loan Balance

(K-$)

	Year 1
	5495.00
	549.47
	10.00
	616.80
	749.11

	Year 2
	9120.00
	1996.47
	21.89
	2149.80
	632.97

	Year 3
	10140.00
	2201.93
	21.72
	2424.60
	504.74

	Year 4
	11020.00
	2353.80
	21.36
	2635.80
	363.12

	Year 5
	12520.00
	2767.80
	20.11
	3105.80
	206.65

	Total
	48295.00
	9869.47
	20.44
	10932.80
	206.65


Financial requirements

Describe the finances you need to cover your projected expenses:

Financial requirements

	
	Year 1
	Year 2

	Equity
	300
	100

	Owners Loans
	0
	100

	Loans
	0
	0

	Other
	0
	0

	Total Financial requirements
	300
	200

	Fixed Assets
	50
	0

	Research & Development
	100
	0

	Working Capital
	100
	200

	Contingency
	50
	0

	Total Financial Needs
	300
	200


The Company - History and Present

This chapter answers the following questions for an existing business:
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What is the business history and how successful has it been ?
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What is the present situation ?

SYMBOL 119 \f "Wingdings" \s 10 \h
Who stands behind the business ?

It also includes the following information about the business:
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The company's main business
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The company's owners
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The financial position and past performance

SYMBOL 119 \f "Wingdings" \s 10 \h
The business target

Main business

Describe the company's main business, objectives, main products, target markets, major customers, positioning in the market, market share, and facilities.

Owners

Identify the company owners, their backgrounds, and skills.

Financial position and past performance 

Explain the financial situation of the business and its performance in the last five years. Define the following items:
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The revenue over the last five years.
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The profit over the last five years.
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The total assets over the last five years.
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The total liabilities over the last five years.
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The main financial ratios over the last five years.

Business targets

Briefly describe the business objectives and targets. The objectives should be concrete and measurable, such as sales target, growth rate, profitability, and market share.

Products and Services

This chapter presents the main products, product lines, or services your business provides. Include the following information:
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How the product meets the market needs
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Product description and specifications
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Product cost
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Competitive products

How the product meets the market needs 

Answer the following questions:
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What is the market demand ?
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How does your product satisfy the market needs ?
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What are the main advantages of the product ?

Product description and specifications

Describe the product's main features and specifications:
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A general description
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The main features
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The main specifications
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The operational method

Product cost

Explain the factors contributing to the cost of your product:

SYMBOL 119 \f "Wingdings" \s 10 \h
Direct labor
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Materials
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Sub contractors
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Other

If you estimate future trends in product costing, present the projected trends.

If you are in the preliminary stage of research and development, describe the expected variance range.

Competitive products

List the major existing or anticipated competitive products, and describe their advantages and disadvantages compared to your product. Present your comparative analysis in a table as follows:

Air Conditioner Analysis

	 
	Competitor

A 
	Competitor

B 
	Planned Product

	Price
	$ 1500
	$ 1800
	$ 1200

	Installation Mode
	Internal
	Internal
	External

	Sizing
	Very Good
	Good
	Super

	Weight
	18 lbs
	22 lbs
	14 lbs

	Size
	38/23/38
	40/35/45
	35/30/40

	Warranty Period
	6 Months
	6 Months
	18 Months

	Service Level
	Good
	Poor
	Very Good

	Noise Level
	Low
	Low
	Very Low


Market Analysis

The market analysis addresses the question, "What is the business potential and the keys for success ?". The market analysis is the basis for deciding on the marketing strategy and the marketing plan.

The Market

Define market characteristics such as:

· General market description

· Business opportunity

· Market segmentation

· Market size & trends

· Competition

· Customer profile

· Business environment

General

Introduce the target market and explain the need and demand, major characteristics, market size, and the business opportunity.

Segmentation

Divide the overall market into specific segments, to evaluate the market. Segment the market according to the following keys:

· By geographical market: split the overall market into geographical marketplaces, such as continents, states, cities.

· By customer type: split the overall market according to customer types such as industries, social & economic parameters, professions, age.

· By application type: split the overall market according to application. 

Market Size & Trends

Evaluate the market size and trends per market segment, and present it in a table similar to the one below:

Market size and trends

	
	20xx
	20xx

	
	Market

Share
	Market Size
	Market Share
	Market

Size

	Automotive Industry
	33 %
	$ 152 M
	45 %
	$ 26 M

	Electronic Industry
	42 %
	$ 193 M
	26 %
	$ 15 M

	Aerospace Industry
	10 %
	$ 46 M
	7 %
	$ 4 M

	Other
	15 %
	$ 69 M
	22 %
	$ 13 M

	Total
	100 %
	$ 460 M
	100 %
	$ 58 M


Competition

Describe your main competitors, addressing the following questions:

· Who is the competition?

· How strong is the competition in the market?

· What is our competition's market share?

· What are the distribution channels?

Customer profile

Provide a potential customer profile, including:

· Short description of the customer

· Short description of purchasing behavior

Business Environment

Define the business environment and how it affects market behavior.

Marketing Strategy

This chapter explains how you plan to bring the product to the markets, at what sales price, how much it will cost you, and how much you will sell. This elements are known as the four P's:

· Product

· Price

· Promotion

· Place

Marketing Objectives

Describe your marketing objectives, including the following goals:

· Profitability goals

· Sales targets

· Market share targets

· Product positioning

Marketing Strategy

Describe your current and projected marketing strategy. Emphasize the reasons for adapting this strategy, covering the following areas:

· The target market and segmentation

· The distribution strategy

· The pricing policy

· The promotion and advertising

· Strategic alliances

· How to address competitors

· The marketing organizational structure

Strengths and weaknesses

The marketing strategy should be based on the company strengths and weaknesses. Outline the following points:

· Technology: Performance, Quality, Uniqueness

· Marketing: Market Share, Distribution, Prices, Image

· Financial: Financial resources, Stability, Financial leverage

· Corporate: Size, People, Goodwill Alliances

Target market and segmentation

Clarify your target market, why you decide to focus on it, and how product, price, promotion, and place match the needs of the specific market segments.

Distribution strategy

Describe your current and projected distribution channels, such as retail and wholesale outlets, direct sales by salesmen, direct mailing, and sole representatives.

Explain why you chose these channels, and describe their structure and competitive advantages.

If you intend to use more than one channel, explain how it will work.

Pricing policy

Explain your pricing policy, discount structure, and the relationship of your prices to your competitors' prices. Include your full price list.

Promotion and advertising

Explain how you intend to promote your products, including advertising, public relations, and other activities.

Strategic alliances

List your current and projected strategic alliances, and explain how they serve your marketing needs.

How to Address Competitors

Explain how you intend to address your competitors, and why you think this is an appropriate strategy.

Marketing Organizational Structure

Explain your marketing organization structure, and the plans for the future. Describe the leading team, facilities, and location.

Marketing activities

List your main marketing activities. For each activity describe its objectives, schedule, and responsibilities.

Sales plan

Present your sales plan, including sales quantities, sales price, and revenue, as in the following table:
	Sales Plan (Units)

	
	20xx
	20xx
	20xx
	20xx

	Telephone - Local
	500
	600
	700
	800

	Telephone - USA
	800
	900
	1,000
	1,100

	Telephone - Europe
	1,000
	1,100
	1,200
	1,300


	Sales Plan (K-$)

	
	20xx
	20xx
	20xx
	20xx

	Telephone - Local
	750
	855
	948
	1,083

	Telephone - USA
	960
	1,026
	1,083
	1,191

	Telephone - Europe
	1,400
	1,463
	1,516
	1,643

	Total Sales
	3,110
	3,344
	3,547
	3,917


Marketing budget

Prepare a marketing budget, as in the following table.

	Fixed Expenses (K-$)

	
	20xx
	20xx
	20xx
	20xx
	20xx

	Exhibitions
	0
	50
	80
	100
	120

	Advertising
	0
	50
	80
	100 
	120

	Brochures
	60
	50
	50
	50
	50

	Travel
	60
	50
	80
	100
	120

	Other
	60
	50
	50
	50
	50

	Total
	180
	250
	340
	400
	460


	Variable Expenses (%)

	
	20xx
	20xx
	20xx
	20xx
	20xx

	Commissions
	25%
	25%
	25%
	25%
	25 %

	Total (K-$)
	61.5
	777.5
	836.0
	86.7
	979.2


Research & Development Plan

A business plan for a new product requires a research and development plan which briefly describes the product plans and risks for producing it. The R&D plan should cover the following:

· A short description of the goals and objectives

· A short description of the main plan

· The major milestones and time table

· The risk and the contingency plan.

· The R&D Budget

The R&D Milestone Chart

	
	Man

Month
	Month

1  2  3  4  5  6  7  8  9 10 11 12

	Preliminary Design
	1
	-->

	Electronic Design
	3
	  --------->

	Machine Design
	6
	    ------------->

	Optical Design
	4
	      ----------->

	Integration
	8
	                   --------->

	Testing
	1
	                            --->

	At Site
	3
	                                 --->

	Final Version
	1
	                                   --->

	Pre Production
	3
	                                         -->

	Total
	30
	


The R&D Budget

R&D - Fixed Expenses ($000's)

	
	20xx
	20xx
	20xx
	20xx
	20xx

	Material
	60
	60
	60
	60
	60

	Sub-Contractors
	60
	60
	60
	60
	60

	Misc.
	12
	12
	12
	12
	12

	Total
	132
	132
	132
	132
	132


R&D - Salaries & Employees ($000's)

	
	20xx
	20xx
	20xx
	20xx
	20xx

	R&D Manager
	1
	1
	1
	1
	1

	Salary per employee ($000's)
	60
	60
	60
	60
	60

	Salary amount ($000's)
	60
	60
	60
	60
	60

	R&D Engineers
	2
	2
	2
	2
	2

	Salary per employee ($000's)
	40
	40
	40
	40
	40

	Salary amount ($000's)
	80
	80
	80
	80
	80

	R&D Technicians
	3
	3
	3
	3
	3

	Salary per employee ($000's)
	35
	35
	35
	35
	35

	Salary amount ($000's)
	105
	105
	105
	105
	105

	R&D Programmers
	4
	4
	4
	4
	4

	Salary per employee ($000's)
	30
	30
	30
	30
	30

	Salary amount ($000's)
	120
	120
	120
	120
	120

	Total Employees
	10
	10
	10
	10
	10

	Total Salaries ($000's)
	365
	365
	365
	365
	365


Management and Organization

The management plan should answer such questions as who manages the company, how is the organization is structured, and how will the management's organization execute the plan.

Management

Briefly describe your management team:

· Position

· Responsibilities

· Experience

· Education

Include resumes of the key personnel in the appendix.

Organization

Outline your organization structure and describe its main units, such as factories, departments, main production lines.

Organization chart
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The Operational Plan

Manufacturing

If your business plan is for the manufacturing industry, describe your production environment as follows:

· The production structure

· The production process

· The facilities and equipment

· The main subcontractors

· The main material suppliers

Services

If your business plan is for the trade or services industry, include the following in your operational plan:

· The operational structure

· The services and activities

· The facilities and equipment

· The main suppliers

Facilities & Equipment

Describe your existing facilities and equipment, and present your future fixed assets investment plan. The plan should include:

· The main equipment, plant, and other required investments

· The cost, including set up expenses

· The purchasing period

The Facilities and Equipment Investment Plan

	
	20xx
	20xx
	20xx
	20xx

	Development Equipment
	200
	0
	0
	0

	Production Equipment
	200
	250
	100
	100

	Office Equipment
	30
	0
	0
	0

	Total Capital Investment 
	430
	250
	100
	100


The Financial Plan

The financial plan provides a full view of the business potential, the profitability, cash requirements, and financial risks. The financial plan should contain the following:

· The financial highlights

· Proforma reports

· Operational budget

· The main assumptions

Financial highlights

The financial highlights should include the following information in tables and graphs:

· Projected sales and revenues

· Projected net profit

· Projected cash flow

· Break even analysis

· Payback period

· Sensitivity analysis

· Financial requirements

· Main assumptions

Example: The Financial Highlights

Willow Corporation's projected revenues for the period 20xx -20xx are about 48 million dollars, which yield over 9.8 million dollars operating profit (20 % return on sales). After the first 5 years, sales of 12.5 million dollars and operating profit of 2.7 million dollars are expected.

Willow Corporation plans to be profitable within one year, with an expected payback period of 2 years (based on 0.6 million dollars investment).

The expected N.P.V. (Net Present Value - discounted by 15%) is about 4.5 million dollars, and the expected I.R.R. (Internal Rate of Return) over the period is above 54%.

Financial Highlights

	Period
	Revenues

($000's)
	Operating Profit

($000's)
	Operating Profit

(%)
	EBITDA

($000's)
	Loan Balance

($000's)

	20xx
	5,495
	549
	10
	617
	749

	20xx
	9,120
	1,996
	22
	2,150
	633

	20xx
	10,140
	2,202
	22
	2,425
	505

	20xx
	11,020
	2,354
	21
	2,636
	363

	20xx
	12,520
	2,768
	22
	3,106
	207

	Total
	48,295
	9,869
	20
	10,933
	207


Break Even Analysis

	QTY (%)
	Revenues ($000's)
	Fixed Expenses ($000's)
	Variable Expenses ($000's)
	Operating Profit ($000's)

	10%
	4,830
	6,908
	3,152
	(5,231)

	20%
	9,659
	6,908
	6,303
	(3,553)

	30%
	14,489
	6,908
	9,455
	(1,875)

	40%
	19,318
	6,908
	12,607
	(197)

	41%
	<--------------- Break Even Point ---------------

	50%
	24,148
	6,908
	15,759
	1,481

	60%
	28,977
	6,908
	18,910
	3,158

	70%
	33,807
	6,908
	22,062
	4,836

	80%
	38,636
	6,908
	25,214
	6,514

	90%
	43,466
	6,908
	28,365
	8,192

	100%
	48,295
	6,908
	31,517
	9,869

	110%
	53,125
	6,908
	34,669
	11,547


Sensitivity (What If) Analysis

	% Change
	Sales

(K$)
	Gross Profit

(K$)
	Gross Profit

(%)
	Operating Profit

(K$)
	Operating Profit

(%)

	-20 %
	4,396
	1,408
	32
	-373
	-8

	-10 %
	4,945
	1,952
	39
	87
	2

	0 %
	5,495
	2,496
	45
	549
	10

	10 %
	6,044
	3,040
	50
	1,011
	16

	20 %
	6,594
	3,584
	54
	1,472
	22


Proforma Profit & Loss Report

	
	20xx
	20xx
	20xx
	20xx
	20xx

	Revenues
	5,495
	9,120
	10,140
	11,020
	12,520

	Direct Costs
	2,876
	4,368
	4,920
	5,418
	6,208

	Production O/H
	55
	91
	101
	110
	125

	Depreciation
	67
	153
	223
	282
	338

	Gross Profit
	2,497
	4,507
	4,896
	5,210
	5,849

	R&D
	497
	497
	497
	497
	497

	Marketing
	848
	1,210
	1,312
	1,400
	1,550

	G&A
	603
	804
	885
	959
	1,034

	Total Operating Expenses
	1,947
	2,511
	2,694
	2,856
	3,081

	Operating Profit
	549
	1,996
	2,202
	2,354
	2,768

	Interest Expenses
	21
	80
	68
	55
	40

	Interest Income
	24
	44
	78
	115
	159

	Other Income
	0
	0
	0
	0
	0

	Other Expenses
	0
	0
	0
	0
	0

	Income Before Taxes
	552
	1,960
	2,212
	2,414
	2,886

	Income Tax Provision
	55
	196
	221
	241
	289

	Net Profit
	497
	1,764
	1,991
	2,173
	2,598

	Acc. Net Profit
	497
	2,262
	4,252
	6,425
	9,023


	Gross Profit (%)
	45
	49
	48
	47
	47

	Operating Profit (%)
	10
	22
	22
	21
	22

	Net Profit before Tax (%)
	10
	21
	22
	22
	23

	Net Profit after Tax (%)
	9
	19
	20
	20
	21


Proforma Cash flow report
	
	20xx
	20xx
	20xx
	20xx
	20xx

	(+) Receivables Payments
	4,735
	9,120
	10,055
	10,947
	12,395

	(-) Purchases Payments
	3,304
	5,423
	5,990
	6,549
	7,400

	(-) Salaries Payments
	1,397
	1,549
	1,704
	1,829
	1,994

	(-) Equipment Payments
	400
	267
	320
	320
	320

	(-) Tax Payments
	0
	55
	196
	221
	241

	Total Disbursements
	5,101
	7,294
	8,210
	8,919
	9,955

	Net Operating Cash Flow
	(366)
	1,826
	1,845
	2,027
	2,440

	(-) Interest Expenses
	21
	80
	68
	55
	40

	(+) Interest Income
	24
	44
	78
	115
	159

	(+) Loans Received
	800
	0
	0
	0
	0

	(-) Loan Payments
	51
	116
	128
	142
	156

	(+) Owners Equity
	1,000
	0
	0
	0
	0

	(-) Dividend Payments
	0
	0
	0
	0
	0

	Cash Flow Requirements
	1,386
	1,674
	1,727
	1,946
	2,402

	Acc. Cash Flow
	1,386
	3,060
	4,787
	6,733
	9,135

	Opening Bank Balance
	0
	1,386
	3,060
	4,787
	6,733

	Net Cash-This Period
	1,386
	1,674
	1,727
	1,946
	2,402

	Closing Bank Balance
	1,386
	3,060
	4,787
	6,733
	9,135

	Credit Line
	200
	200
	200
	200
	200

	Deficit in Funds
	0
	0
	0
	0
	0

	P.V.
	(379)
	1,381
	1,213
	1,159
	1,213

	N.P.V. (Acc.)
	(379)
	1,001
	2,215
	3,374
	4,587


Proforma Balance Sheet report

	
	20xx
	20xx
	20xx
	20xx
	20xx

	Cash
	1,386
	3,060
	4,787
	6,733
	9,135

	Receivables
	760
	760
	845
	918
	1,043

	Inventory
	728
	728
	820
	903
	1,035

	Current Assets
	2,874
	4,548
	6,452
	8,554
	11,213

	Fixed Assets
	400
	720
	1,040
	1,360
	1,680

	Acc. Depreciation
	67
	221
	443
	725
	1,063

	Total Assets
	3,207
	5,047
	7,049
	9,189
	11,830

	Payables
	905
	957
	1,071
	1,160
	1,312

	Tax Payable
	55
	196
	221
	241
	289

	S.T. Borrowings
	0
	0
	0
	0
	0

	Current Liabilities
	960
	1,153
	1,292
	1,401
	1,601

	L.T. Borrowings
	749
	633
	505
	363
	207

	Total Liabilities
	1,710
	1,786
	1,797
	1,764
	1,807

	Owners Equity
	1,000
	1,000
	1,000
	1,000
	1,000

	Retained Earnings
	497
	2,262
	4,252
	6,425
	9,023

	Liabilities & Net Worth
	3,207
	5,047
	7,049
	9,189
	11,830


The Basic Assumptions 

The financial projection is based on the following data and assumptions:

	Discount rate
	15%

	Interest rate 
	10%

	Interest rate - Credit
	5%

	Inventory cycle
	2 Months

	Production O/H
	10% of material & subcontractors

	Sales commissions
	5% of sales

	Marketing Expenses
	10% of sales & staff cost

	G & A
	5% of sales & staff cost


Depreciation period (Straight line) in years:

	Plant 
	20

	Production line
	10

	Office equipment
	5

	Computers
	5


Salary level (in $ thousands per year):

	Direct labor 
	30

	Indirect production
	40

	R&D
	50

	Engineering
	50

	Marketing
	60

	G&A
	50


A Business Planning Checklist

Executive Summary

· The business plan objectives

· The business description and objections

· The products and services

· The market & business opportunity

· The financial highlights

The Company - History and Present

· The company main business

· The company owners

· The financial position and past performance according to the following:

· The sales

· The profits

· The total assets

· The liabilities

· The main financial ratios

· The business objectives

The Products and Services

· Describe your products and services

· How the product meets the market needs 

· What is the market demand

· How your product fits the needs

· Its main advantages

· The product description and specifications

· A general description

· The main features

· The main specifications

· The operational method

· The product costing

· Direct labor

· Materials

· Sub contractors

· Other

· The competitive products

The Market Analysis

· Define your market and market segmentation by:

· Geographical market place

· Customer type

· Application type

· Evaluate the market size and trends per market segment. Table presentation is recommended.

· Describe your main competitors including:

· Who is the competitor

· How strong is the competitor in the market

· What is the competitor's market share

· What are the distribution channels

· Define the potential customer profile including:

· Short description of the customer

· Short description of his purchasing behavior

· Describe the business environment and how it affects the market behavior

The Marketing Strategy and Plan

· The marketing strategy and objectives

· Profitability goals

· The target market and segmentation

· Sales targets

· Market share targets

· The product positioning

· Describe your existing and planned marketing and sales activities including:

· The marketing organizational structure

· The sales and distribution channels

· The main marketing and sales activities

· Explain your pricing policy and establish your product sales price

· Promotion and advertising

· Strategic alliances

· Addressing the competition

· Describe the marketing organizational structure

· Present your sales plan including: sales quantities, sales prices and revenues.

· Present the marketing budget

The Research & Development Plan

· A short description of the goal and objectives 

· A short description of the main plan

· The major milestones and timetable 

· The risks and the contingency plan. 

· The R&D budget

Management & Organization 

· Present the key personnel and describe their:

· Position

· Experience

· Education

· Draw your organizational structure and describe the main sub-organization units such as: factories, departments, main production lines.

· If your business plan deals with the manufacturing industry you should describe your production environment as follows:

· The production structure

· The special production process

· The special facilities and equipment

· The main subcontractors

· The main material suppliers

Facilities and Equipment

Describe your fixed assets investment plan. The plan should include:

· The main equipment, plant and other investments required.

· The cost, including the set up expenses

· The purchasing period

The Financial Plan

· The main issues to be presented in the financial highlights are:

· Projected sales and revenue

· Projected net profit

· Projected cash flow

· Break even analysis

· Payback period

· Main sensitivity analysis

· Financial requirements

· Present the Proforma reports for the next five years:

· Profit & Loss

· Cash Flow

· Balance Sheet

· Operational Budget

· Explain your financial assumptions.
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